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Abstract

The chick chorioallantoic membrane (CAM) model has been widely used to study different
biological and medical processes, including angiogenic response, tumor development and
drug-delivery. Such studies can be achieved because of the naturally immunodeficient
system the chicken embryos possess the first couple of weeks of its development. The CAM
of a developing chicken embryo provides an in vivo model, easily accessible for vascular
and tumor imaging. In this master’s thesis, the chorioallantoic membrane model was used
to estimate the tumor vascular characteristics of human prostatic adenocarcinoma and
human osteosarcoma. The same estimates were conducted on normal vasculature, and
used as a control for comparison. Tumor vasculature is characterized by heterogeneous,
abnormal blood vessels, both in structure and function. These irregularities give rise to
enhanced vascular permeability, which is an important factor to consider in the delivery
of therapeutic agents to tumors. The characteristics of tumor vasculature also lead to
an increase in interstitial fluid pressure, which can result in a physiological barrier to the
delivery of therapeutic agents

The experiments were performed by first inoculating cancer cells on the CAM’s surface at
day 6 of the embryo development. At day 13 or 14, fluorescent dextrans were injected into
the blood vessel network, and visualized with an epi-fluorescent, widefield microscope.
The characterizations involved estimates of different parameters, related to blood vessel
permeability and the microvascular architecture. This included vascular extravasation
rate of two sizes of dextrans (3-5 kDa and 40 kDa), vascular fraction, vascular number
of branching points and vascular fractal dimension of both outlined and skeletonized
branching patterns.

The dextran extravasation rate, from the vessels and into the extravascular extracellular
space, was estimated by measuring the development of fluorescent intensities in both
compartments over time. The 40 kDa dextran showed no significant difference between
the vascular extravasation in the two cancer types. Neither were there any significant
differences between extravasation in the two cancer types, when compared to the control
vasculature. The smaller 3-5 kDa dextran, showed a high extravasation rate in the control
vasculature, significantly higher than the prostatic tumor vasculature.

Vascular fractions, number of branching points and fractal dimensions, were estimated
and used as characterizations of the microvascular architecture. The osteosarcoma vascu-
lature showed significantly higher values in all these parameters compared to the control
vasculature. The prostatic vasculature had only a significant higher number of branching
points and fractal dimension (based on skeletonized branching pattern), compared to the
control.

The extravasation rate of 40 kDa dextran was further related to the microvascular struc-
ture, and a significant correlation was found between the extravasation rate and fractal
dimension (based on outlined branching patterns). With the estimates on microvascular
structure, a significant correlation was found between the number of vascular branching
points and fractal dimension (based on skeletonized branching patterns).

In conclusion, the CAM did not yet prove to be a precise model to study differences in
vascular permeability by estimating the vascular extravasation rate. However, the model
showed more promising results on the characterization of microvascular architecture, by
detecting significant differences between tumor growth and normal tissue.
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Sammendrag

Chick chorioallantoic membrane (CAM) modellen har vært mye brukt for å studere
forskjellige biologiske og medisinske prosesser, inkludert angiogenesis, tumorutvikling og
levering av legemidler. Slike studier kan gjennomføres på grunn av det naturlige im-
munodefisiente systemet som kyllingembryoer innehar det første ukene. CAM-en til et
kyllingembryo i utvikling tilbyr en in vivo modell, som gir lett tilgang til avbildning av
blodårenettverket og tumorer. I denne masteroppgaven, er CAM modellen brukt til å
estimere karakteristikkene til blodåreveksten hos krefttypene prostatic adenocarcinoma
og osteosarcoma. De samme estimeringene ble også gjort hos normal blodårevekst, og ble
brukt til sammenligning. Blodårenettverket i tumorer er karakterisert som heterogene,
unormale blodårer, både når det gjelder struktur og funksjon. Disse uregelmessighetene
fører til økt vaskulær permeabilitet, noe som er en viktig faktor å ta i betraktning ved
levering av terapeutiske stoffer til tumor. Karakteristikkene til tumor vekst fører også til
et økt interstitielt væsketrykk, som kan resultere i en fysisk barriere imot leveringen av
terapeutiske stoffer.

Eksperimentene ble gjort ved å først overføre kreftceller til CAM-overflaten på dag 6
av embryoets utvikling. På dag 13 eller 14, ble fluorescerende dextraner injisert inn
i blodårenettverket og visualisert med et epi-fluorescent, widefiled mikroskop. Karak-
teriseringen involverte forskjellige parametere, relatert til blodårepermeabilitet og den
mikrovaskulære strukturen. Dette inkluderte vaskulær ekstravasasjonsrate av to forskjel-
lige størrelser dextraner (3-5 kDa og 40 kDa), vaskulær fraksjon, antall vaskulære for-
greiningspunkt og vaskulær fraktal dimensjon, av både blodårenes omriss og skjelett.

Ekstravasasjons raten av dextraner, fra blodårene og ut i ekstravaskulær ekstracellulære
rom, var estimert ved å måle utviklingen av fluorescerende intensiteter i begge kam-
rene over tid. 40 kDa dextranet viste ingen signifikant forskjell mellom den vaskulære
ekstravasasjonenraten i de to krefttypene. Heller ingen signifikant forskjell ble funnet
for vaskulære ekstravasasjon i kreftblodårene, sammenlignet med de normale blodårene.
Det mindre 3-5 kDa dextranet, viste høy ekstravasasjonsrate i de normale blodårene,
signifikant høyere enn blodårene for prostatakreft.

Vaskulær fraksjoner, antall vaskulære forgreiningspunkt og fraktale dimensjoner, ble es-
timert og brukt til å karakterisere den mikrovaskulære strukturen. Blodårene hos os-
teosarcoma viste signifikant høyere verdier i alle disse parameterne sammenlignet med
kontrollblodårene. Prostatablodårene hadde signifikant høyere antall forgreiningspunkt
og fraktal dimensjon basert på blodåreskjelettet, sammenlignet med kontrollblodårene.

Ekstravasasjonsraten hos 40 kDa dextranet ble videre relatert til den mikrovaskulære
strukturen, og an signifikant korrelasjon ble funnet mellom ekstravasasjonsraten og den
fraktale dimensjonen basert på blodårenes omriss. Med estimeringene gjort på den
mikrovaskulære strukturen, ble en signifikant forskjell funnet mellom antall forgrein-
ingspunkt og den fraktale dimensjonen basert på blodåreskjelettet.

For å konkludere, så ga ikke bruken av CAM en presis modell til å studere forskjellene i
vaskulær permeabilitet gjennom å estimere ekstravasasjonsraten. Når det er sagt, så viste
modellen mer lovende resultater ved karakteriseringen av den mikrovaskulære strukturen,
hvor signifikante forskjeller ble funnet mellom tumorvekst og normalvev.
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Chapter 1: Introduction

1.1 Background and motivation

The Division of Biophysics and Medical technology at NTNU are in the process of using
the chorioallantoic membrane (CAM) model to study and characterize tumors. The
model was established in my prior specialization project to this master’s thesis. However,
a characterization of the angiogenesis and leakiness of tumors growing on the CAM was
still missing.

Compared to the CAM model, other in vivo assays often lack quantitative and repro-
ducible results, and are often complex and expensive, and may require surgical skills [2].
The CAM model, addresses these problems, and has become a commonly used model
to study angiogenesis and tumor development. The CAM is an unique model because
of its naturally immunodeficient environment in the first 14 days of the embryonic de-
velopment. This property makes it possible for the chicken embryo to accepts cancer
cells and transplantation from various tissues and species without starting an immune
response [3]. The model also has the advantage of having a circulatory system already
3 days after fertilization of the egg and can be grown ex ovo in a petri dish placed in
an incubator. As the CAM develops, the blood vessel network can easily be accessed,
manipulated and observed, and hence provides an optimal setting for angiogenic assays
[4]. The circulatory system is also suitable for injections of drugs and to study their
effects. The method where tumors are transplanted onto the CAM is well-established,
where Rous and Murphy [5] already in 1911, demonstrated the growth of the Ruos 45
chicken sarcoma transplantation onto the CAM. Later, in 1913, Murphy also reported
successful tumor xenografts from mice, transplanted onto CAMs, which were maintained
by continuous transplantations over to newer CAMs [6].

Compared to other models, including the in ovo CAM model, the ex ovo culture of
chicken embryos allows a significant improvement in accessibility, continuous monitoring
and visualization. With the entire membrane being visible and available, multiple grafts
and inoculations can be placed on each CAM. Compared with mammal models, where
tumor growth takes 3-6 weeks, the CAM model is much faster, where tumor xenografts
become visible after only 2-5 days after tumor implants [2].

The aim of this master’s thesis is to characterize the tumor vasculature growing in CAM.
The model can be further used to study the behaviour of nanoparticles and drugs cir-
culating in blood vessels, their extravasation across capillary walls and their interactions
with extracellular matrix compartment. Furthermore the model can be used to estab-
lish and design an experimental set up to perform ultrasound treatment on the CAM,
and study the effect of ultrasound delivery of drugs and nanoparticles. Hopefully, this
master’s thesis will give a solid foundation for this future work.
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1.2 Objectives

The main objectives of the master’s thesis are

1. Study the leakiness of the blood vessels in cancer tissue by injection of fluorescent
tracers of different dextran sizes.

2. Do a vascular characterizations of two different cancer types, PC3 and OHS, which
have shown different vascular density and permeability when grown in mice. The
characterization includes vascular fraction, vascular number of branching points
and fractal dimension.

3. Do the same experiments on a control group for comparison, and compare the
results with other studies as well.

1.3 Structure of the thesis

The structure of this thesis is as follows:

• Chapter 2 describes the relevant theory used in this master’s thesis. Including
the embryonic development with focus on the CAM, cancer development, imaging
methods, image processing and theoretical mathematics.

• Chapter 3 describes the method on how all the experiments were conducted. Here
are methods for both work in the cell laboratory and experiments done in the CAM
laboratory. One can also find the description on how the imaging experiments were
conducted, as well as the method for image processing and analysis. Since other
students will continue the work with the CAM model, the method is kept at an
very detailed level.

• Chapter 4 presents the results from the experiments.

• Chapter 5 discusses the results in Chapter 4, along with comparisons to other
studies.

• In Chapter 6, a brief conclusion of the master’s thesis is presented, along with
recommendations for further work.

• The Appendix includes relevant information that could be useful to have if one was
to repeat any of the work conducted in the master’s thesis. All the images obtained
throughout the experiments can also be found here.
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Chapter 2: Theory

2.1 The developing chick embryology

The embryonic development starts within the ovum, which is the female sex cell. The
ovum is the part of the egg commonly known as the yolk, which is the term usually used
after the egg is laid. Within the ovum, there is a small white disc on the surface, called
the germinal disc or blastodisc. The germinal disc contains half the genes from the hen,
and the other half comes from the rooster’s sperm cells which fertilize the ovum inside
the hen’s oviduct [7].

After the egg is laid, the activation and further development into an embryo, first starts
when the egg is incubated. The chicken embryo development lasts 21 days from it is
first activated and until it hatches. Within the eggshell there are four extra-embryonic
membranes with important tasks related to the development before hatching, the yolk,
the amnion, the chorion (also called serosa), and the allantois [2]. The outermost cover
of the egg, is the egg shell, which protects the whole egg and preventing it to dry out
while still permitting air to reach the embryo. Between the chorion and the eggshell, is
the albumin, also known as the egg white. Figure 2.1 is a schematic diagram showing the
extra-embryonic membranes as the chicken develops inside the egg.

Figure 2.1: Schematic diagrams from Duval [8], showing the extraembryonic membranes of the chick in
ovo. A) Embryo about two days old. B) Embryo about three days old. C) Embryo about five days old.
D) Embryo about fourteen days old.
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The yolk produces an enzyme that changes the yolk material into a form that can be
used as a food source by the developing embryo. The amnion forms a fluid filled sac
covering the embryo. In this way the amnion provides a shock-absorbing environment
where the fragile embryo can develop without harm from normal day to day knocks[9, 10]
The functions of the allantois and the chorion are more closely described in Section 2.1.1,
which addresses the chicken chorioallantoic membrane (CAM), a composition formed by
the fusion of the allantois and the chorion membranes. Figure 2.2 shows ex ovo images
of two different stages of the embryonic development.

Figure 2.2: Labeled ex ovo cultures. To the left is an ex ovo culture at day 3 of the embryonic devel-
opment. At this stage, the heart and chorioallantoic vasculature are clearly visible. To the right is the
same ex ovo culture at day 9. At this stage, the CAM and the embryo have increased significantly in
size, and features like the embryo’s eye and leg are clearly visible.

The chickens are protected by an immune system with a dual composition of B and T cells.
The B cells control the antibody immunity, and are first detected at day 12. While the T
cells control the cell mediated immunity, and are first detected at day 11 [11]. Thus, the
chicken immune system does not begin to develop to function until about 2 weeks into its
development, and by day 18 chicken embryos become completely immunocompetent [12].
This trait of being naturally immunodeficient, makes the chicken embryo accept foreign
influences without starting an immune response. This makes it possible to implant cancer
cells and do transplants from various tissues and species.
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2.1.1 The chicken chorioallantoic membrane (CAM)

The CAM is formed by the fusion of the chorion and the allantois within the period from
day 3 to day 5 of incubation [3, 13]. Figure 2.3 shows a 5 days old embryo, where one
can see the developing CAM above and close to the embryo.

Figure 2.3: "Macroscopic in ovo features of the chick chorioallantoic membrane (CAM) at day 5 of incu-
bation. Original magnification is 30X" [3]. The amnion sac is surrounding the embryo. The developing
CAM is placed in the surface above the amnion and embryo, but still connected to the embryo. The
image is retrieved from Ribatti [3].

The CAM of a developing chicken embryo mediates in the exchange of gas and nutrients.
It removes waste by storing it in the allantoic cavity, and participate in the electrolyte
transport from the allantoic sac, transporting calcium from the shell to start the bone
mineralization [2]. However, the main function of the CAM is to serve as the respiratory
organ for the embryo, by oxygenating the blood and eliminating carbon dioxide. The
embryo is unable to carry out this function by itself, and is thus completely dependent
on the CAM. It is the allantois that develops the extensive circulatory system, which
is connected to that of the embryo and driven by the heart [9]. The chorion help the
respiration by fusing the inner shell membrane to the allantois and eliminating carbon
dioxide through the pores in the shell[3].

As the embryonic development goes on, the CAM increases in size. According to Rhan et
al., the surface area of the CAM increases from approximately 6 cm2 at day 6 to 65 cm2

by day 14 [14]. By day 16 of incubation, the CAM covers most of the yolk sac [3]. Prior
to day 11, the endothelium of the CAM, which lines the interior surface of blood vessels
and lymphatic vessels, is a rapidly dividing cell population. After day 11, endothelial
cells divide only infrequently and gradually acquire the morphological characteristics of
the final arrangement of the lining of blood vessels [15].

The CAM consists of three layers: ectoderm, mesoderm and endoderm [3]. The ectoderm
is a chorionic epithelium layer of cells, with connected vascular elements. The mesoderm
is an intermediate allantoic layer of mesenchyme, containing the main blood vessels.
This rich vascular system that develops within the mesodermal layer, is served by paired
allantoic arteries and paired allantoic veins. The endoderm is the innermost layer of
allantoic epithelium [15, 16]. Figure 2.4 from Ribatti [3] shows the orientation of the
three layers.
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Figure 2.4: A semithin section of the CAM, showing the chorionic epithelium (CH), the intermediate
vascularized mesenchyme (M), and the deep allantoic epithelium (AL). Original magnification, 160X.
The image is retrieved from Ribatti [3].

2.2 Cancer

The risk of being diagnosed with cancer increases with age [17]. In 2014, 92.9% of all
cancers were diagnosed in persons aged 50 years or above [18]. Studies done in the
United States showed that as a lifetime risk, the probability of getting cancer in the age
interval from birth to death is 40.8% for men and 37.5% for women (based on data from
2011-2013) [19].

The uncontrolled proliferation is a defining feature of cancer cells, however this is not the
sole property that makes cancer so dangerous. Also the cells of benign tumors proliferate
uncontrollable, but such tumors remain in their original location and are usually easy to
remove by surgery. The real danger posed by cancer comes from the cells of malignant
tumors, with uncontrolled proliferation in combination with the ability to invade nearby
tissue and spread, or metastasize, throughout the body. Nearly 90% of all deaths caused
by cancer is due to the spread of cancer, rather than by the primary tumor itself [20].
Chemotherapy using cytotoxic drugs is the most common treatment for cancer, however
there are many improvements to be done. One way of improving the delivery, is to target
the tumor vasculature and inhibit tumor angiogenesis [21]. To do this, one would have to
know about the compositions and characteristics, like angiogenesis and leakiness, of the
blood vessels found in the different types of cancer.

In the following Sections 2.2.1 - 2.2.5, theory on tumor angiogenesis, vascular structure
and permeability is first described, before presenting the two cancer types used in this
master’s thesis.
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2.2.1 Angiogenesis

For metastatic spread of cancer tissue, growth of the vascular network is important. The
development of the vascular network is done by a process called angiogenesis [22]. Tumor
angiogenesis is a regulated process, forming new blood vessels [21]. For tumors to grow
beyond a few millimeters in diameter, angiogenesis is required to maintain the delivery
of nutrition and oxygen. To trigger the angiogenesis, tumors release signaling molecules.
The main angiogenesis-activating molecules are the two proteins: vascular endothelial
growth factor (VEGF) and fibroblast growth factor (FGF). These proteins are produced
by many cancer cell types, and also by certain normal cells [20]. When VEGF and/or FGF
proteins are released into the surrounding tissue by the cancer cells, they bind to receptor
proteins on the surface of the endothelial cells. The binding activates a signaling pathway
causing the endothelial cells to divide and secrete protein-degrading enzymes called matrix
metalloproteinases (MMPs). The extracellular matrix is broken down by the MMPs,
creating free space. The endothelial cells are then able to migrate into the surrounding
tissues and develop new blood vessels [20]. Figure 2.5 shows the increased angiogenic
activity of a CAM assay treated with VEGF, compared to an untreated control.

Figure 2.5: Angiogenesis assay using CAM. There are more blood vessels in the sample treated with
VEGF (right) compared to the untreated control (left). Image retrieved from Szkudlarek et al. [23].

The blood vessel growth is controlled by a balance between angiogenesis activators and
inhibitors. It is not enough that the tumor cells release angiogenesis-activating molecules
to create blood vessel growth. The activators must overcome the inhibitors that are nat-
urally present to restrain the growth of blood vessels. When tumors trigger angiogenesis,
it is usually achieved by an increase of angiogenetic activators and a simultaneous de-
crease in the production of angiogenetic inhibitors [20]. When the activators do overcome
the inhibitors, there is a shift of the tumor microenvironment to an angiogenic state, or
"angiogenic switch" [24]. The angiogenic switch is a very important stage of the tumor
development [21].
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2.2.2 Tumor vascular structure

The tumor vasculature is significantly heterogeneous and differ from normal vasculature
with respect to organization, structure, and function [25]. Tumor vasculature is known to
be more chaotic in appearance than normal vasculature [26, 27]. This difference is clearly
shown in Figure 2.6, with abnormal, tortuous tumor vessels and normal, well-organized
vessels. Vascular density and branching pattern are some of the parameters that can
be used to determine the tumor vascular structure. The vascular density is generally
evaluated by estimating the fraction of the image area or volume covered by vessels [28],
and is shown to be larger in tumor tissue [25]. The branching pattern can be analyzed
by considering the branching point densities between the blood vessels and by a fractal
analysis. The number of branching points will consequently increase with the increasing
chaotic appearance of tumor vasculature.

Figure 2.6: Left) Abnormal, tortuous tumor vessels. Right) well-organized normal vessels. The figure is
retrieved from Reitan et al. [26]

The fractal analysis represents a reliable method for describing and summarizing object
complexity and heterogeneity, and it is a consistent, objective method to evaluate scale,
size and shape. Fractal analysis deals principally with two main measures: lacunarity and
fractal dimension. The lacunarity is a measure of the rotational and translational invari-
ance, i.e. its heterogeneity or texture. The fractal dimension is a measure of an object’s
complexity [29], describing the irregular, tortuous contours and branching structure. A
complex and irregular pattern is characteristic for tumor microvasculature [26, 28], hence
the fractal dimension is shown to be higher in tumor microvasculature compared to nor-
mal microvasculature [30]. In this master’s thesis, fractal analysis is conducted to obtain
the fractal dimension. The calculation of fractal dimension is described in more detail in
Section 2.4.2.

As cancer cells proliferate, many tumors expand in mass beyond the support capacity of
the existing vasculature as well as the inflicted angiogenesis. This will lead to decreased
levels of oxygen which can lead to hypoxic areas. As a result, the level of nutrients
decreases and an accumulation of metabolic wastes develops, and finally, with no oxygen
delivery, prolonged hypoxic areas turn into necrotic areas in the inner areas of the tumor
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[31, 32]. Necrotic areas are common in fast growing cancer types, where the growth rate
exceed the angiogenesis [32, 33].

2.2.3 Blood flow and vascular permeability in tumors

As mentioned above, the tumor vasculature is significantly heterogeneous compared to
normal vasculature [25]. The abnormal vascular structure and high geometric resistance
to blood flow, causes a spatially and temporally heterogeneous blood flow rate [34]. The
geometrical resistance for a vascular network is complex, depending on vascular mor-
phology (i.e. the number of vessels of different types), branching pattern, and the vessel
length and diameter [34]. The heterogeneous tumor vasculature also includes the qual-
ity of the vessel walls. Tumor tissue have in general poorly developed capillary walls,
with fenestrations between the endothelial cells, a discontinuous endothelial cell layer,
and a partially absent basal lamina resulting in increased permeability, i.e. leaky vessels
[35]. The increased permeability of tumor vessels compared to normal vessels has been
demonstrated in several previous quantitative studies [36, 37, 38]. Even though the tu-
mor vessels have an overall increase in permeability, parts of the vessel walls can also
appear similar to normal vessels, giving a heterogeneous permeability within one tumor.
Not only does the vascular permeability vary from one tumor to the next, and spatially
within the same tumor, but it also varies temporally during tumor growth, regression,
and relapse [35, 39].

The high permeability contributes to a better transcapillary transport of therapeutic
macromolecules, which can be exploited to deliver nanomedicines. This phenomenon,
which allows particles of a preferential access to tumors by virtue of size and circulation,
is called the enhanced permeability and retention (EPR) effect [40]. The EPR effect
describes how relatively large carriers of drug molecules will tend to accumulate in tumor
tissue, much more than they will do in normal tissue because of the enhanced permeability
[41]. EPR has long been one of the fundamental and promising principles of cancer drug
delivery, because of its believed simplicity and effective therapy [40]. However, clinically
outcomes have indicated that EPR is not so reliable after all [40, 41, 42]. The interstitial
fluid pressure (IFP) of normal tissues is actively regulated through interactions between
the connective tissue cells, i.e. stromal cells, and the extracellular-matrix molecules [43].
Proliferating tumor cells produce a solid stress, compressing the blood and lymphatic
vessels. As a result, the IFP is significantly elevated in solid tumors [35]. There are a
number of factors that contribute to the increased IFP in the tumor growth, including
vessel abnormalities, formation of excess fibrous connective tissue i.e. fibrosis, and con-
traction of the interstitial matrix mediated by stromal fibroblasts [43]. The increased
IFP results in a physiological barrier to the delivery of therapeutic agents to tumors [35].
Tumor cells and ECM are also unevenly distributed, creating regions within a tumor
that are inaccessible to nanocarriers, especially in the absence of convective flow due to
elevated interstitial fluid pressure [40]. Because of the high IFP, diffusion becomes the
major transport mechanism in solid tumors [26]. Figure 2.7 shows both the conventional
and more realistic presentation of EPR [40].
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Figure 2.7: Conventional (top) and more realistic (bottom) depictions of EPR. A simple figure of EPR
present the tumors as having uniformly fenestrated blood vessels and large gaps between the tumor cells.
This allows for rapid penetration into the tumor interstitium. A more realistic figure shows unevenly
distributed openings in the blood vessel. The unevenly distributed tumor cells and ECM causes regions
within the tumor that are inaccessible to the nanocarriers. The figure is retrieved from Nichols et. al[40].

2.2.4 PC3 - Prostatic adenocarcinoma

Prostatic adenocarcinoma takes place in the gland for production of seminal fluids at the
base of the bladder in males. It is the fourth most common cancer type worldwide, and
the second most common cancer type among men. For the time period 2012-2014, the risk
for developing prostate cancer, among men, was 11.55%. The risk for dying was however
much lower, with only 2.45% [44]. The cancer type is especially common among elderly
men [45]. In 2012 an estimation of 1.095 million men were diagnosed with prostate
cancer. In 2020 it is estimated that 1.393 million men worldwide will be diagnosed
with prostate cancer [46], an increase of 27% compared to 2012. Prostate tumors are
particularly heterogeneous, i.e. composed of cells with different phenotypic characteristics
and different proliferative and malignant potentials [47]. Effective treatments, involving
surgery and radiation, exist for clinically localized prostate cancer. However, metastatic
prostate cancer remains essentially incurable [48].

The PC3 cells are an established cell lines derived from human prostatic adenocarcinoma
metastatic to bone. The PC3 tumors have a very low vascularity compared to many
other cancer types [21], which is supported by Figure 2.8 [49]. Figure 2.9 shows that PC3
tumors also mainly have blood vessels in the tumor periphery.
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2.2.5 OHS - Osteosarcoma

In the time period 2012-2014, the risk for getting bone cancer was 0.08%, while the risk
for dying of bone cancer was 0.04%, giving a survival rate of 50% [44]. Osteosarcoma,
also called osteogenic sarcoma, is the most common primary bone cancer malignancy and
derives from primitive bone-forming mesenchymal cells [17, 50]. It is most prevalent in
young people and affects more males than females [51]. It usually forms in the ends of
long bones in the body, for instance arms and legs. In children and young adults, it often
forms in the bones near the knee. Infrequently, osteosarcoma can be found in soft tissue
or organs in the chest or abdomen [51]. The osteosarcoma cell line, OHS, was established
from a patient in 1985 at The Norwegian Radium Hospital. The patient was a 14 year
old boy with multiple skeletal manifestations of osteosarcoma, developing 13 years after
treatment for bilateral retinoblastoma [52].

The OHS sarcoma is well vascularized, and compared to PC3, OHS tumors have a high
vascular fraction, both in the periphery [Fig. 2.9] and throughout the tumor [Fig. 2.8]
[49]. A study on the EPR effect in dogs with cancer, showed that for spontaneous tumors,
sarcomas had a low uptake of nanocarriers compared to carcinomas [53]. However, it
cannot be considered a general feature of solid malignant tumors, as it was also observed
a high degree of accumulation heterogeneity between tumors.
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Figure 2.8: C) Vascular fraction of the entire tumor for different types of cancer. D) Vascular fraction
in the outer 0.6mm rim of the tumors. Each symbol represents one tumor, and the mean and SD are
given for each tumor model. The figure is retrieved from Sulheim et al. [49]

Figure 2.9: Histograms of the relative distance between blood vessel and the tumor rim. The PC3 has
blood vessels mainly in the periphery, while OHS has blood vessels almost throughout the whole tumor.
The figure is retrieved from Sulheim et al. [49]
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2.3 Epi-fluorescence imaging

In this master’s thesis, the Axio Imager 2Z fluorescence microscope was used to visualize
the vascularization, inside of tumor growth sites in the CAM. The microscope is an
upright, widefield light microscope which is able to run multidimensional experiments
including multichannel acquisition, z-stacks with Apotome mode for optical sectioning,
and time-lapse [54]. In thick samples, the signal from the focal plane is compromised by
the out of focus light coming from planes above and below. The result is a blurred, low
contrast image, which is impossible to make three-dimensional projections of. Apotome
is a mathematical technique, developed to remove the out of focus light. In the Apotome,
a grid is inserted in the illumination pathway, with a plane-parallel glass plate placed in
front of the grid. The glass plate tilts back and forth, projecting the grid in the image
in three different positions. For each step in depth, three raw images with the projected
grid in three different positions are taken. The projected images of the grid are further
processed by the software, which calculates and removes the out of focus light. If the
grid is visible, the obtained signal is in focus. If not, the signal is out of focus, and thus
removed [55].

The microscope is capable of performing epi-fluorescence imaging in combination with
transmitted-light brightfield, darkfield and differential interference contrast (DIC) [54].
The most important microscope property in our experiment, is the microscope’s ability to
take fluorescence images with the light source illuminating the from above. A fluorescence
microscope is equipped with a high-intensity light source. In this case, the high-intensity
light source was a HXP 120 Metal halide fluorescence illumination with intensity control
[54]. A metal halide lamp has a broad spectrum, from ultraviolet and throughout the
visual spectrum. When the high-intensity light source illuminates from above, the objec-
tive lens is used both as a illumination condenser and as a fluorescence light collector [56],
i.e. performing epi-fluorescence imaging. A simple sketch of the principle of fluorescence
imaging is shown in Figure 2.10.

Figure 2.10: A) A high-intensity light source sends light to an excitation filter which limits the trans-
mitting wavelengths by blocking all wavelengths under a certain value. The dichroic mirror reflects
light under a certain wavelength towards the sample. B) The illuminated sample absorb the light and
re-irradiate the energy at longer wavelengths, i.e. the emitted fluorescent light. The dichroic mirror
transmits the light with wavelengths longer than a certain level, which then hit the emission filter. Ex-
citation wavelengths backreflected or scattered at the sample are reflected by the dichroic mirror back
towards the light source. Excitation wavelengths that manage to pass through the dichroic mirror are
blocked by the emission (barrier) filer. The Figure is retrieved from the prior specialization project [57].
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The wavelength of illumination is chosen by placing an excitation filter after the light
source. There are several fluorescence filters to choose from, allowing imaging from DAPI
to Cy5 region (from blue to deep red). The filter creates an excitation beam by limiting
the passing through light to a narrow range of wavelengths by blocking out wavelengths
under a certain value. The excitation beam then reflects on a dichroic mirror (beam
splitter) towards the sample. A dichroic mirror will reflect light under a certain wave-
length and transmit wavelengths over a certain level. The reflected light goes through
the objective lens, which work as a condenser, and onto the sample. The sample irradiate
the absorbed energy at longer wavelengths, i.e. fluorescence light, going up towards the
objective lens. The objective lens collects the emitted fluorescent light, before it passes
through the dichroic mirror and the emission filter, before finally reaching the eye or
camera. Excitation wavelengths that are backreflected or scattered at the sample, are
reflected by the dichroic mirror out towards the light source. Any excitation wavelengths
that manage to pass through the dichroic mirror are blocked by the emission filter, which
is also called the barrier filter. Thus, this arrangement allows detection of only the light
emitted from the fluorescent substances in the sample. The three optical filters (excita-
tion, dichroic and emission/barrier) are together referred to as a fluorescence filter set or
cube. Depending on the excitation/emission-spectrum of the fluorescent sample, the user
selects different wavelengths by choosing between different filter sets.

2.3.1 Fluorescent dyes and filters

Dextran conjugates are characterized by their varying molecular weight, good water sol-
ubility, low toxicity, and relative inertness [58], and are thus a good choice for imaging
blood vessels. To get the best imaging of the blood vessel conformation, fluorescent la-
beled dextrans with molecular size large enough to not leak out of the blood vessels,
are useful. If one on the other hand wants to examine the leakiness of blood vessels,
the use of smaller dextrans, where one compare different sizes, is a good approach. By
mixing a large dextran with a smaller dextran labeled with different fluorescent dyes, one
can image both the structure and the leakiness of blood vessels at the same time (by
changing filter sets) with only one injection. To do this, it is important the fluorescent
excitation/emission spectra is different enough to be separated by the fluorescent filters
within the microscope. The dextran conjugates used in this master’s thesis were labeled
with tetramethylrhodamine (TMR), tetramethylrhodamine isothiocyanate (TRITC) and
fluorescein isothiocyanate (FITC).

TMR and TRITC is a red and pink fluorescent dye, respectively. TMR has a fluorescent
excitation/emission spectra with excitation maximum at around 555 nm and emission
maximum at around 580 nm [58]. TRITC has a very similar spectra, with excitation
maximum around 550 nm and emission maximum around 577 nm [59]. The Zeiss Filter
Cube Set 43HE (also called DsRed filter) has an excitation filter at 550/25 nm, emission
filter at 605/70 nm and a dichroic mirror at 570 nm (reflect wavelengths under 570 nm,
and transmit wavelengths above) [60]. Hence, the 43HE filter set is a suitable filter for
both TMR and TRITC labeled dextrans. Figure 2.11 shows the fluorescence scope for
the 43HE filter set.
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Figure 2.11: The fluorescence scope for the 43HE filter set, suitable for imaging TMR and TRITC labeled
dextrans. Retrieved from Carl Zeiss Microscopy filter assistant [60].

FITC is a yellow/orange fluorescent dye [61]. The excitation maximum of FITC-dextran
is 490 nm and the emission maximum is 520 nm [61]. To visualize FITC labeled dextrans,
the Zeiss Filter Cube Set 38HE (also called FITC filter) is suitable. The filter set has an
excitation filter at 470/40 nm, emission filter at 525/50 nm and a dichroic mirror at 495
nm [62]. Figure 2.12 shows the fluorescence scope for the 38E filter set.

Figure 2.12: The fluorescence scope for the 38HE filter set, suitable for imaging FITC labeled dextrans.
Retrieved from Carl Zeiss Microscopy filter assistant [62].

2.4 Image post-processing and data analysis

2.4.1 ImageJ

ImageJ is a free, Java-based image processing and analysis program developed at the
National Institutes of Health (NIH), USA [63] (available from the NHI at https://
imagej.nih.gov/ij/). ImageJ has various different built in options for analysis and
processes. The program also allows plugin installation, giving a very good selection of
ways to analyze and process images. ImageJ’s built in editor and Java compiler can be
utilized to develop user-coded plugins to suit the specific requirements of any conceived
application, thus making it possible to solve almost any image processing or analysis
problem [63, 64].
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2.4.2 Fractal dimensions

The geometrical dimensions, given as the integer 1 for a line, 2 for a square, and 3 for
a cube, are well-known facts. However, the geometrical dimensions can be extended to
include patterns with nonlinear scaling rules, called fractal dimensions, D [27, 29]. In
this master’s thesis, the fractal dimensions were determined using Fractal Box Count in
ImageJ. The box-counting method first divide the image into a grid of boxes of size L.
The size of the boxes is changed progressively to smaller sizes, and the corresponding
number of nonempty boxes, N(L), are counted [30]. Figure 2.13 shows how the box size
decrease in Figure 2.13B to cover the pattern of nonempty boxes given in Figure 2.13A.
Hence, the N(L) boxes is the number required to cover the boundary of a one-pixel
binary object portrayed as an outline or skeleton of the blood vessel branching pattern.
The fractal dimension can then be calculated from the slope of a log-log plot of the box
size and the smallest number of boxes needed to completely cover the boundaries of the
vessels within the image [26, 27, 28]. The box-counting fractal dimension of each image
is given by [30]:

Db = lim logN(ε)
log(1/ε) , (2.1)

where Db is the box-counting fractal dimension of the image, ε is the side length of the
box, and Nε is the smallest number of required boxes of side-length ε. Because the
limit 0 cannot be applied to natural objects or physical representations of mathematical
fractal objects [30], the dimension is calculated by D = - slope, of the plot of Eq. (2.1)
[26, 30, 65].

Figure 2.13: A) The Sierpinski carpet. B) Coverage of the Sierpinski carpet by boxes of decreasing size,
where L is the box size and N is the number of boxes needed to cover the object. The figure is retrieved
from Baish et al.[27].
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2.4.3 Extravasation rate

Vascular permeability, i.e. leakiness, can be estimated by analyzing the extravasation
rate. This estimation can be done by using a method described by Patlak et al. [66]. The
method is based on plots, called Patlak plot, of the ratio of the extravascular extracellular
space (EES) and intravascular concentration of the injected tracer, against a modified
time axis. Here it is assumed that the concentration is proportional to the fluorescent
intensity [26]. For each real time point, t, of the experiment, the modified time, T, is
given by the integrated concentration of tracer in blood until time t divided by the actual
concentration of the tracer at time t [67]. Thus, the values along the ordinate axis are
given by the ratio [67]:

y = Ct(t)
Cvess(t)

, (2.2)

where Ct(t) and Cvess(t) are the extra- and intravascular concentration at time t.

The modified time axis is given by [67]:

T =
∫
Cvess(t)
Cvess(t)

. (2.3)

Assuming a net irreversible accumulation of fluorescent tracers in the EES over time after
the injection, it follows that the plot becomes linear after equilibrium is reached [26]. The
linear line that defines the terminal slope of the plot is equal to the rate constant, Ki,
describing the net irreversible transport of the fluorescent tracers from the capillaries to
the EES. The extravasation rate can thus be estimated by fitting an exponential function
to Eq. (2.2) as a function of Eq. (2.3) [67]:

y(T ) = (α +KiT )(1 − e−γT ), (2.4)

where α and γ are constants. As T becomes large, y(T ) increases linearly with T , with the
positive slope Ki [66]. This makes it possible to find the extravasation rate by excluding
the first measurement(s) of Eq. (2.3) at low T and fitting the curve with Eq. (2.4), giving
the linear regression line:

y(T ) = α +KiT. (2.5)
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Details about the specific reagents and equipment that were used, can be found listed
alphabetically in Table E.1 and E.2 in Appendix E. Table E.1 contains materials used in
the cell laboratory and table E.2 contains the materials used in the CAM laboratory.

3.1 Cell culture

Continuous cell cultures were maintained and used to inoculate the CAMs. The proce-
dures for cell culturing and splitting used in this project is described in detail in Appendix
F and G, for the cell lines PC3 and OHS, respectively. The cell culturing for the two
cell lines is quite similar and a short description of the method for cell splitting is de-
scribed below. The medium used was made by adding 50 ml FBS to a 500 ml bottle with
cell culturing medium suitable for the specific type of cell line (DMEM-41965 for PC3,
RPMI-1640 for OHS). 5 ml penicillin-streptomycin were added to the 500 ml medium
bottle to avoid any possible infections.

The sterile bench and all the equipment were sterilized, while the medium, PBS and
trypsin were heated in a 37◦C water bath. 15 minutes later, the old medium was removed
from the cell culture flask, before adding 5 ml PBS. The PBS was subsequently removed
before adding 3 ml trypsin and placing the flask in 37◦C for 2-3 minutes. This was
done to detach the cells from the flask. 7 ml medium was then added to the flask. The
amount of medium had to exceed the amount of trypsin to stop the trypsin activity.
The cell suspension was pipetted gently, detaching the cells from each other. 10 ml cell
suspension was transferred over to a 14 ml centrifuge tube, and centrifuged with 1500 rpm
for 5 minutes. Meanwhile the cells were counted using a Bürker chamber. The procedure
for counting and calculation can be found in Appendix G.

After the cells were centrifuged and counted, the supernatant was removed and medium
was added to give 1 million PC3 cells per ml, or 2 million OHS cells per ml. The
suspension was gently pipetted, removing all lumps, before the wanted number of cells
was transferred over to a new, sterile culture flask. Usually 1.5 million PC3 cells, or 2
million OHS cells, were transferred to a TC75 flask. Finally, medium was added to the
flask, giving a total volume of about 15 ml, before labeling it and placing it in the cell
incubator. The incubation was conducted at 37 ◦C with 5% CO2.

The medium was changed before it ran out of nutrition. This was done midway between
the seeding and the splitting. The sign of low nutrition can be seen as the color changes
(from red/pink to yellow in this case). The procedure was simply done by removing the
old medium from the culture flask before adding new, pre-heated medium. The color
change is also seen when cells die due to overcrowded flasks. The cell splitting should
be conducted before it reaches this stage. A full TC75 culture flask with PC3, contain
about 4-5 million PC3 cells. OHS cells are smaller and grow faster than PC3, and thus
a full TC75 culture flask with OHS, contain between 10 and 16 million cells. By seeding
out 1.5 million PC3 cells, or 2.0 million OHS cells, a TC75 culture flask is usually full
about 4 days after splitting.
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3.2 Preparations, incubation and ex ovo culture

The fertilized eggs used in this master’s thesis were delivered by Nortura SA. Usually 60
eggs were received per delivery, which were divided in groups of 20, so that not all 60 eggs
were developing simultaneously. The eggs were stored at 3◦C before they were placed in
the incubator. They were not stored longer than one week, as this would increase the
number of deaths and inactivations.

3.2.1 Incubation

Before the eggs were put in the incubator, dirt, feathers and/or excrement was carefully
removed from the egg shells by dry wiping them with hand paper towels. The incubator
was designed to hold the eggs vertical, and thus the eggs were placed with the pointier
end facing down. This was done to keep the yolk centered and keep any bacteria far away
from the yolk. Air and bacteria enter the egg through the blunt end, where the air sac is
located (see Figure 2.1). So, if the egg is stored with the blunt end down, the air pocket
can rise, touch the yolk and increase the risk for damage and contamination [68].

The humidity of the incubator was kept at 60-80% and incubation temperature at 37.5◦C.
The eggs were continuously and automatically tilted from left to right every 2nd hour in
the incubator. This was important as it prevented the yolk to stick to the eggshell, and
consequently being destroyed when the egg was cracked. The yolk can also attach to the
eggshell if the humidity of the incubator is too low over time.

3.2.2 Ex ovo culture

After three days in the incubator, the eggs were taken out of the incubator and laid on
the side. Laying the eggs on the side will allow the embryo to move more to the center of
the of the egg, by rising towards the new highest point.This makes it easier to crack the
egg without damaging the embryo and blood vessels. 2-3 eggs at a time were taken out
of the incubator to be more efficient, but still keep the eggs in room temperature for a
short time. The eggs were sterilized by wiping with hand paper towel sprayed with 70%
ETOH. The eggs were carefully kept in the same horizontal level when wiping them. It is
important to not use too much ETOH nor to wait too long after the wiping until cracking
the egg. This is because the ethanol will be absorbed in the eggshell, making it porous
and more difficult to crack without damaging the yolk and the embryo. The eggs were
cracked on an 80 mm triangular magnetic stir bar, laying perpendicularly oriented to the
long axis of the egg. The eggs were cracked inside a sterile bench, using tight, sterilized
gloves. However, the air ventilation was turned off, as this would dry out the surface of
the egg content and increase the chance for the yolk and/or the blood vessels to rupture
and leak.

It is important that the egg membrane, as well as the eggshell, is cracked open. Leakage
of egg white, after the encounter with the stir bar, was a safe sign that the egg membrane
had been perforated. If only the eggshell was cracked, the membrane was perforated
by gently pressing one or two fingers against the membrane. When an egg was cracked
open, the content was gently put in a plastic container of suitable size. After a successful
cracking, with the embryo and blood vessels still intact, the container was placed in a
petri dish. To maintaine sufficient humidity, the bottom of the petri dish was filled with
sterile water. To protect and hold on to some of the extra humidity, the petri dish lid
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was, without stopping the air inlet, placed on top of the plastic container. When this was
completed, the ex ovo cultures were placed one by one in a second incubator. Here the
temperature was kept at 37.7 ◦C, and the humidity was maintained by always keeping a
tub with sterile water at the bottom of the incubator. The CO2 supply was turned off to
make a better environment for embryonic development.

3.3 Inoculation

To use the CAMs for cancer related research, cancer growth was initiated in the CAMs
by inoculating the two cell lines, PC3 and OHS, onto the surface of the CAMs. A control
group, without induced cancer, was also carried out.

3.3.1 Cell preparation for inoculation

The cell harvesting for inoculation was performed by doing the cell splitting as described
above in Section 3.1, except that less medium was added to make a much higher density
of cells, and in addition ECM gel was added. ECM gel is a gelatinous protein mixture
prepared from Engelbreth-Holm-Swarm sarcoma in mice, and resembles the complex
extracellular environment [69]. The gel was used in these experiments as a substrate for
the inoculating cells. Since the ECM gel harden within 5 minutes at 20◦C, any work
with the ECM gel had to be conducted under low temperatures, preferably not higher
than 10◦C. This was to be sure that the product would maintained liquefied under the
preparation. So, to prevent the gel from hardening, the cell mixture was made by first
adding the medium and keeping it on ice, before adding the ECM gel with precooled
pipette tips. The cells, medium and ECM gel were gently mixed together to prevent
bubbles to form. A cell mixture with many bubbles, is more difficult to equally distribute
among the CAMs.

The cell mixture was made with a density of 1.75 ×106 cells per 35 µl mixture, comprised
of a 1:1 ratio of cell medium and ECM gel. 35 µl cell mixture gave one inoculation.
Because the inoculation of the CAMs involved the use of many pipettes (one per inocu-
lation), a noticeable amount was lost during the inoculation. Hence, the amount of cell
mixture was made to suit one extra CAM per 10-15 CAMs.

3.3.2 Inoculation of cells onto the CAMs

At day 6 of the embryo development, the CAMs were ready for inoculation. At this stage
the actual CAM does not extend over a very large area, but can be seen as membrane
above and close to the embryo, with superficial blood vessels. To facilitate the inoculation
of cells and the angiogenic process, the CAMs were gently traumatized by scratching with
a sterile tweezer, creating a very small blood spot [4]. If the scratching is very invasive,
it can over the next few days lead to death, thus it should be done with caution. To keep
track on where the cells were placed on the CAM, sterile plastic rings were placed onto
the CAMs, surrounding the traumatized area. After a ring was placed, 35 µl cell mixture
was pipetted into the ring. To prevent the ECM gel to harden before it was placed on
the CAMs, the mixture was put on ice and the pipette tips were cooled down in a freezer
prior to the procedure. The exact same procedure was also done for a control group, only
without the cells, i.e. the inoculation mixture consisted of 1:1 medium (DMEM-41965)
and ECM gel. Figure 3.1 shows the ring placement on two different CAMs. The CAM
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itself is marked with dotted lines. In agreement with Figure 2.1, the early developed
CAM is located in the front and above the embryo. From Figure 3.1 one can see that the
size of both the CAM and embryo can differ a lot even though they are at the same age.

The rings were made by first using a hole puncher to make holes in the flat bottom of a
weighting boat, giving a 5 mm inner diameter. Then the rings were shaped by cutting
approximately 1.5 mm around the holes with scissors. The smooth side of the ring was
placed down towards the CAM. This is because sharp edges, caused by the cutting, can
induce unwanted micro lesion as the embryo grow and cause movements in the CAM.
It is important to keep everything as sterile as possible, but when the inoculation was
performed, the air ventilation of the sterile bench was turned off, like when the eggs
were cracked, to prevent the surface to dry out. Thus, the bench was sterilized with the
air ventilation turned on a time prior to the inoculation, and then turned off when the
inoculation began. After the procedure, the CAMs were placed back into the incubator.

Figure 3.1: Figure showing the ring placement on two different CAMs, 6 days after activation. There
are noticeably differences between CAMs when it comes to size and development. The CAM itself can
be difficult to see by looking at images, so here the boarder of the CAM is marked with dotted lines,
however, it is easier to see in reality.

3.4 Injection of dextrans

In agreement with Mattilsynet, the embryos had to be sacrificed when they were 14 days
old. So, to give the cancer cells and vasculature time to evolve and grow, the CAMs were
injected with labeled dextran and examined at day 13 or 14. Since the injections and
imaging intervals were such a heavy strain on the embryos, all embryos were sacrificed
after the examinations were completed, regardless if the embryos were 14 days old or not.
This was quickly done by decapitation using a scissor.

If the surface of the CAM dries out, it can give unwanted autofluorescence. To prevent
this from happening while imaging longer time series, a drop of PBS was put on the
imaging site, i.e. covering the inoculation ring and its content. To obtain reliable images
with good quality, motion of the chick embryos needed to be minimal. For this purpose,
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the embryos were sedated with a dosage of 0.3 mg/kg medetomidine, in agreement with
Waschkies et al. [70]. The medetomidine solution was diluted in PBS to give 0.05 mg/ml.
The total content of an egg was approximately 50 g, giving an application volume of 0.3
ml per CAM. The onset of the anaesthesia occurred within 10 minutes and continued to
function for the following 30 minutes [70]. Hence, the anaesthesia was applied 10 min
before injection and imaging, and for longer imaging intervals, a new dose was applied
before the anaesthesia stopped working.

To be able to visualize the blood vessels, as well as any leakage, fluorescent tracers com-
posed of different sizes of dextrans were mixed with PBS and injected into the blood
vessel network. As mentioned in Section 2.3.1, FITC has a different fluorescence excita-
tion/emission spectra compared to TMR and TRTIC, which have quite similar spectra.
This difference in excitation and emission makes it suitable to mix FITC with TMR or
TRITC, and still show only one fluorescence at a time by changing the microscope filter
set to suit the different excitation/emission spectra.

The shape and structure of the blood vessel network were well visualized by injection of 2
MDa dextrans, labeled with either FITC (Sigma-Aldrich, FD2000S) or TMR (Invitrogen,
D7139), into the vessels. 2 MDa dextrans are so large that they won’t penetrate the
capillary walls. Two types of injections were done, where these large labeled dextrans
were mixed with smaller dextrans with a different fluorescent label in order to show the
leakiness of the blood vessels. One injection type was composed by 2 MDa FITC-dextran
mixed with 40 kDa TMR-dextran (Invitrogen, D1842) or 40 kDa TRITC-dextran (Sigma-
Aldrich, 42874). The other type of injection was composed by 2 MDa TMR-dextran mixed
with 3-5 kDa FITC-dextran(Sigma-Aldrich, FD4). 100 µl were injected per CAM, and it
was done next to the microscope to image the extravasation of the injected dextrans as
soon as possible.

The mixing ratios were first decided by comparing the intensities from the two fluorescent
dextrans (FITC and TMR or TRITC) by imaging a small sample of the mixtures on a
microscope slide using the same exposure time for the two different filter sets. The amount
of labeled dextrans were then adjusted to give a similar intensity by calculating the
equation: A[mg] * intensity A = B[mg] * intensity B, with dextran type A and B, where
the intensities are given as gray scale values extracted from the image processing program
ImageJ (the use of ImageJ is elaborated in Section 3.6). However, from experience, the
intensity of the smaller dextrans decreases significantly when injected into the CAM
compared to the mixture sample on the microscope slide. Thus, the mixing ratio should
show some higher intensities for the smaller labeled dextrans (40 kDa TMR/TRITC-
dextran and 3-5kDa FITC-dextran) compared to the large 2 MDa dextrans. The final
mixing ratios found to be used here were: 8 mg 2 MDa FITC-dextran together with 12
mg 40 kDa TMR-dextran or 25 mg 40 kDa TRITC-dextran per 1 ml PBS, and 10 mg 2
MDa TMR-dextran together with 16 mg 3-5 kDa FITC-dextran per 1 ml PBS.

Injections in the blood vessels are not easy and need some practise. Even though the
FITC-dextrans are yellow, the mixture with TMR or TRITC give a reddish color. Because
of the similar color to blood, it can be challenging to see right away if the mixture is
injected into the vessel and distributed in the blood vessel network, or if it is injected
into the surroundings. To easier know for sure that the injection was successful, a very
small amount of PBS was pulled up with the needle, filling only the needle and not the
syringe. Hence, the needle was filled with colorless PBS which didn’t blend noteworthy
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with the fluorescent mixture in the syringe. By doing so, one could easier see through the
blood vessel that the content entered the vessel. Another advantage with filling the needle
with PBS is that it if one discovers right away that the injection is not successful, one
can stop the injection without spilling the fluorescent dextrans outside the blood vessel.
If a substantial amount of dextrans is spilled, it can ruin the experiment, especially if the
experiment is conducted to investigate the blood vessel permeability. As a precaution to
this, and any bleeding caused by the injections, the injections were always done far away
from the inoculation site.

Since the vessels are so tiny, one is dependent on having small enough needles. Here both
27G ×11/2” (Sterican, B.Braun, 9186182) and 30 G ×11/2” (BD Microlance 3, Becton
Dickinson, 304000) needles were used. The 30 G needles were easier to use, as these are
smaller and thus can penetrate smaller vessels without rupturing the vessels. The needles
were attached to 1 ml solo syringes (Injekt-F, B.Braun, 9166017V). The blood vessels
move easily when trying to penetrate them with the needles, thus a tweezer was used
to hold, and slightly pull the vessels in the opposite direction of the injecting direction.
The injections were always done in vessel branching points, as this was much easier. The
chosen vessels were preferably as small as possible to minimize the bleeding. After the
dextrans were injected, the needles were kept still for a short time to let the dextrans be
transported away from the injection site. In that way, the dextrans wouldn’t, in some
extent, follow the bleeding out of the vessels as the needles were drawn away. To avoid
a lasting, massive bleeding after the needles were removed, small sutures (with thread
size 6-0 or 7-0) were performed to close the holes in the injected blood vessels. If the
injected vessel was large and/or had an extensive network on both sides of the injection
site, sutures were made on each side. If the injection site was located more at the outer
edge of the network, just one suture was made, closing only the blood rich side of the
injection site. To minimize the bleeding, the sutures were prepared before the injections,
so that one only needed to tie the knots after injecting the dextrans. When a successful
injection and suturing were completed, the CAM was placed on the microscope sample
stage, ready for imaging.

3.5 Fluorescent widefield imaging with Zeiss Axio Imager 2Z

The microscope used in this master’s thesis belongs to the Department of Biotechnol-
ogy at NTNU, and it is an Axio Imager 2Z upright light microscope from Zeiss with
widefield epi-fluorescence imaging. While imaging, the CAMs were placed on top of a
HP-1M warming plate, with MTC-1 Micro Temperature Controller (Physitemp Instru-
ments, Inc.), maintaining a temperature of 37◦C. The CAMs waiting to be imaged were
placed on top of a HP-1 heat pad liner (Wilfa) with a styrofoam box placed as a lid over
the CAMs to keep the heat and humidity. The microscope was used to obtain images of
the areas where the cancer cells were inoculated, as well as areas of cancer free control
groups. The microscope could be controlled in the AxioVision Rel. 4.8.2 imaging soft-
ware, provided by Zeiss, and all images taken for further analysis were acquired by using
the Zeiss AxioCam MRm.

The EC Plan-Neofluar 2.5X/0,075 objective (Zeiss, 420320-9901) was used, which gives
a total 25X magnification. The reason for using relatively low magnification was mainly
because it gave better image quality, as it wouldn’t be as affected by movements in the
CAM. The objective was chosen before medetomidine was put into use, and thus it may
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have been possible to use larger magnification if medetomidine had been used from the
start. However, independent of medetomidine, the heart was pumping, and thus it was
always some movement caused by the pulsation.

After the fluorescent dextrans were injected into the blood vessels, the CAM was placed
on the sample stage. The CAM was not in focus in both the oculars and the camera at the
same adjustment, thus the "Live" button on the tool bar was selected, which showed live
image from the active camera in a new window. Then the focus knob was adjusted to give
a focused live image. To be able to analyze the leakage of fluorescent dextrans out of the
blood vessels and into the extravascular extracellular space (EES), images were taken of
the same location on the CAM over a time period. Since suturing the injected vessel and
microscope adjustments took some time, it wasn’t possible to take images immediately
after the injection. Thus, the times series of images were taken approximately 2 minutes
after the injection and every second minute until 12 minutes. Further on an image of the
same location was taken 60, 90 and 120 minutes after the injection.

Because of the injected TMR, TRITC and FITC excitation and emission spectra, the
DsRed filter was used to visualize the injected TMR or TRITC labeled dextrans, while
the FITC filter was used to visualize the injected FITC labeled dextrans (as described
in Section 2.3.1). This was controlled by choosing "FITC" or "DsRed" in the tool bar.
Before taking the image, the exposure time was adjusted under "Properties" in the tool
bar located in the live image window. When taking images over time to see the leakage,
it is important to notice which exposure time is used on the first image and make sure to
use the same exposure time on the following images. Images were captured by the Snap
button in the tool bar. First an image showing the 2 MDa fluorescent dextran injection
was captured, i.e. using the FITC-filter if the CAM was injected with 2 MDa FITC
and DsRed-filter if the CAM was injected with 2 MDa TMR. This would give a good
image showing the structure of the blood vessels. Then the filter was changed to show
the smaller fluorescent tracer injection and used to capture the following time series of
images.

When most of the experiments were carried out, the microscope lightguide was slightly
damaged, giving an uneven light distribution. This led to images being darker in the
upper left corner and brighter in the lower right. The light guide was eventually changed,
and thus all images of the control group and the two last of the OHS group were imaged
with an even light distribution.

3.6 Further processing and analysis of data

The data obtained by the Axio Imager 2Z were analyzed through different methods to
characterize the vasculature of the two cancer types. To analyze the data, the image
processing program ImageJ (Version: ImageJ2) was used. Many of the plugins that were
used had to be installed subsequently. This was easily done by downloading the JAR
file to the wanted plugin found at https://imagej.nih.gov/ij/plugins/. The plugin
installation was done by choosing Plugins>Install Plugin and opening the downloaded
JAR file in ImageJ.
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3.6.1 Image scale bars

Since the microscope was not calibrated to give scale bars, scale bars of the correct size
had to be added onto the images afterwards. This was done by first taking a picture of a
micrometer calibration glass-slide ruler in the used magnification. The number of pixels
in a known distance along the ruler was measured in ImageJ. This was done by drawing
a straight line along the known distance on the ruler and choosing "Analyze>Tools>ROI
manager...", clicking on ’Add [t]’ and then ’Measure’. The result showed the length of
the line in number of pixels, and hence the real length of one pixel in the image could be
calculated. In our experiments, 1 pixel was equal to 2.5 µm. By choosing Analyze>Set
Scale, this value was inserted, resulting in a precise scale bar, which then could be applied
to other images (with the same magnification), by choosing "Analyze>Tools>Scale bar...".

3.6.2 Vascular permeability

To analyze blood vessel leakage, time series of a CAM were first put together in a stack
in ImageJ by choosing the "Stacks Menu>Images to Stack" on the quick access menu.
The stack was normalized to gray scale values, 0-255, by "Plugins>Stack Normalizer",
where 0 = black and 255 = white. By changing the gray scale values to 0-255, the
vessels and fluorescent extravasation into the EES, were better visualized compared to
the background tissue. Because of movements in the CAM while imaging, the blood
vessels in the images were not aligned throughout the stack. This was solved, to some
extent, by "Plugins>Template Matching>Align slices in stack" and selecting a rectangle
region as the landmark on a reference slice.

Several ROIs were then placed at different locations on the first slice image, in pairs,
with one inside a vessel and one in the EES. The size of the ROIs was regulated at ’Auto
ROI Properties’ in the Time Series Analyzer V3 window, using diameters ranging from
25-50 µm. The ROIs in the EES were placed a short distance away from the vessels (6±1
pixel, i.e. 15±2.5 µm), to avoid fluorescence contribution from the intravascular area.
In addition, the chosen positions had minimal visual movements below the focal plane,
and didn’t involve vessels shutting down (being black compared to functioning vessels).
When all the ROIs were carefully placed on the first slice, the ROIs were measured in the
ROI Manager window (appears automatically when the Time Series Analyzer V3 starts).
The mean intensity for each ROI was found in the result table. The same measurements
were then conducted for each slice. When moving on to the next slice, the ROIs from
the first slice were automatically transferred over to the other slices, making it easier to
do the measurements. However, because of movements in the CAM, the ROIs were very
often manually moved as well to have the exact same location as in the previous slice.

3.6.3 Vascular fraction

A type of analysis relating to the microvascular structure, was done by calculating the
ratio of pixels covered with blood vessels per unit area, and hence finding the vascular
fraction. If the image included parts of the plastic ring, and/or one or several mas-
sive blood vessels (approximately >400 µm in diameter), a suitable area of the image,
excluding these areas, was chosen for further analysis. A duplicate was then made at
"Image>Duplicate...". The duplicate was manipulated with a Gaussian blur filter found
at "Process>Filters>Gaussian Blur...". After testing several values to give the best re-
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sult, the Gaussian blur value, called "Sigma (Radius)", was set to 25. The Gaussian blur
image was then subtracted from the original image by "Process>Image Calculator...",
and hence creating a homogeneous image. To be able to calculate the area covered by
blood vessels, the threshold of the output image was adjusted to 0-1 gray scale values
(of a total 255) at "Image>Adjust>Threshold...", which then only included the vessels.
The wanted threshold values were adjusted by using ’Default’ and ’Over/Under’. The
’Over/under’ function was not a necessity, but was used as it clearly visualized whether
the area fraction was calculated by the vessels or the tissue outside the vessels. The
type of measurements were set at "Analyze>Set Measurements...", where ’Area’, ’Area
fraction’ and ’Limit to threshold’ were included. The results gave the blood vessel area
fraction, given in both number of pixels and percentage. A mean vascular fraction was
calculated for each of the three groups, PC3, OHS and control.

3.6.4 Number of branching points

Another type of microvascular structure analysis was done by calculating the number
of branching points between the blood vessels in a chosen area. This was done by the
ImageJ function for neurite tracing found at "Plugins>Segmentation>Simple Neurite
Tracer" (V3.1.1), where the "Enforce non-inverted grayscale LUT" was selected. This
plugin function allowed manually drawing of the blood vessel network in the image. Each
path segment was drawn by choosing a start and end point along a blood vessel. The
drawn blood vessel branching points included vertically crossing vessels as well, as it was
difficult to separate those vessels that were linked together and those who just crossed
paths in different planes. When the whole network was completed, ImageJ calculated the
number of branching points by choosing Analysis>Render/Analyze Skeletonized Paths
and "Obtain summary". An image showing only the blood vessel paths and a summary
over the rendered paths were produced. The number of branching points were given
in the obtained summary. To compare the results with other images, the number of
branching points were divided by the image area. A mean number of branching points
were calculated for each of the three groups, PC3, OHS and control.

3.6.5 Fractal dimensions

The fractal dimension, D, was calculated by using the FracLac plugin in ImageJ. In
order for FracLac to analyze an image the image must be converted to a binary outlined
or skeletonized image. Hence, the images obtained by the "blood vessel area"-procedure,
described in Section 3.6.3, was used to make a binary outline. The images were converted
to binary by selecting "Process>Binary>Make Binary". The image outline was made by
"Process>Binary>Outline". If the resulting outlines gave a somehow misrepresented
outlined pattern, flaws were removed by erasing them with white brush color. This
was done to remove patterns that appeared inside larger blood vessels and significant
background noise between vessels. In addition to the outlined images, the branching
patterns from Section 3.6.4 was made binary and used to find the skeletonized, fractal
dimension.

When the fractal pattern of an image was ready, the fractal analysis was done by first
selecting "Plugins>Fractal Analysis>FracLac" in ImageJ. After opening the FracLac win-
dow, a scan was set up by choosing "Box Counting Fractal and Lacunarity Analysis"
("BC") in the FracLac menu. Here the image type was set to "Use Binary", and the

25



3.6 Further processing and analysis of data Chapter 3. Method

number of grid position was set to 8 under grid design. The higher the number of grid
positions, the greater the chance of finding a more efficient covering, but only to some
extent. A higher number of grid positions will in addition increase the processing time,
especially with larger images. Under graphic options, "colour code" was turned off and
the "regression" was turned on. The fractal analysis were performed by selecting the
"Scan" button in the FracLac menu. By using the scroll bar at the bottom of the "plot
and regression line" window, the program visualized the different regression lines obtained
from each box counting scan, i.e. the number of grid positions. All the obtained fractal
box dimensions, DB, were presented in the "Box Count Data Per Grid" window, and
as the slops of the different regression lines. In the "Box Count Summary" window the
fractal dimension, D, was given as the average of all the DB values, and was used as
the resulting fractal dimension for the analyzed CAM. Two mean fractal dimensions, for
both outlined and skeletonized images, were calculated for each of the three groups, PC3,
OHS and control.

3.6.6 Calculations of extravasation rate

The ROIs obtained in Section 3.6.2 were pairwise, EES and intravascular, put in Eq.
(2.2). A mean ratio was calculated by all the paired ROIs for each time interval starting
at 2 minutes in one CAM. These mean ratios were then plotted against the modified time
axis given in Eq. (2.3) to create a Patlak plot. Since the concentration in the numerator
in Eq. (2.3) was integrated over time from injection of the tracer, the modified time axis
ended up with equal values to the original time axis. As described in Section 2.4.3, the
extravasation rate Ki was found by placing a linear regression line for large T , which
here was chosen to be from 4 to 12 minutes. A mean Ki, with standard deviations, were
calculated and plotted for each of the three groups (PC3, OHS and control), and for both
of the injected dextran sizes (40 kDa TMR/TRITC and 3-5kDa FITC).

3.6.7 Statistics

A two-sample, two-tailed student’s t-test assuming non-equal variance, was used to per-
form a statistical comparison of data from control and tumor growth vasculature. The
alpha value was set to 0.05 and the hypothesized mean difference was set to 0. By com-
paring two data sets using the student’s t-test, the results were significantly different
from each other if the obtained p-value was smaller or equal to 0.05. Correlation anal-
ysis of microvascular structural parameters and extravasation rate, were also conducted
with a significance criterion of p ≤ 0.05. The goodness of the linear fit, which describes
how well a linear regression fits a set of observations, was estimated by the coefficient of
determination R2. The statistical calculations were done using Microsoft Excel.
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The results consist of different types of image processing which will help to characterize
tumor vasculature. This includes vascular permeability, vascular fraction, number of
branching points and fractal dimension. All analyzed images are captured using 25X
magnification.

4.1 Vascular Permeability

The vascular permeability was analyzed by plotting a Patlak plot for a time series of
images and calculating the extravasation rate by fitting the linear regression line for large
T , as described in Section 3.6.2. In this section, only the images of one CAM for each
group, and for each of the two dextran sizes, 40 kDa and 3-5 kDa, are included. However,
all the images related to vascular permeability, and the obtained Ki value, for each CAM
are found in Appendix C and D, for 40 kDa and 3-5 kDa dextrans, respectively. The
vascular permeability is analyzed for injections of the relatively large 40 kDa TMR and
TRITC dextrans, and the small 3-5 kDa FITC dextran. Because of few successfully
obtained data from longer time series, only the Patlak plots and Ki-values up to 12
minutes after injection is included in this chapter. The data obtained for longer time
series are included in Appendix C and D.

4.1.1 Larger dextrans: 40 kDa TMR and TRITC dextrans

Representing the three groups, PC3, OHS and control, Figure 4.1-4.3 shows examples
of the different ROIs in an image taken of PC3- and OHS-inoculated CAMs and cancer
free control CAM, respectively. All images included in this section were injected with 40
kDa TMR or TRITC dextran, and 2 MDa FITC dextran. However, the following images
show only the 40 kDa dextrans using the DsRed filter set.
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Figure 4.1: PC3 #3) Image of PC3 inoculated CAM, 2 minutes after injection of 40 kDa TMR dextran.
The positions of ROIs are shown as yellow circles.

Figure 4.2: OHS #1) Image of OHS inoculated CAM, 2 minutes after injection of 40 kDa TMR dextran.
The positions of ROIs are shown as yellow circles.

Figure 4.3: Control #3) Image of cancer free CAM, 2 minutes after injection of 40 kDa TRITC dextran.
The positions of ROIs are shown as yellow circles. The image appears brighter than Figure 4.1 and 4.2
because it contains a black edge at the boarder of the plastic ring in the lower right corner, which will
affect the stack normalization done in ImageJ. However, this will not affect the ratio of the EES and
intravascular fluorescence intensity used to create the Patlak plot.
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Time series: CAM with PC3

Figure 4.4 shows the time series from 2 to 12 minutes after injection of 40 kDa dextrans.
The CAM was inoculated with PC3 at day 6, and the ROIs were measured according to
Figure 4.1. The vessel structure appears to have varying branching patterns and to be
more irregular and chaotic, compared to normal straight vessels. This indicating tumor
development.

Figure 4.4: PC3 #3) Time series showing the same CAM after injecting 40 kDa TMR into the vasculature.
The images are chronologically arranged, from left to right, by the time after injection and with a 2 minute
interval between each image. The first image at the top left is taken 2 minutes after injection, and the
last image at the bottom right is taken 12 minutes after injection. The CAM was inoculated with PC3
cells at day 6, and the images were taken at day 13. The ROIs were measured in the positions illustrated
in Figure 4.1. The images show an increasing intensity in the upper right corner with time. This will
have a brightening effect on the whole image.

The times series [Fig. 4.4] shows an increasing intensity over time in the upper right
corner. This is due to a large vessel moving beneath the focal plan and into the FOV.
Because of the high fluorescent intensity in the large vessel, the whole FOV experiences
a brightening effect, which decreases with distance away from the vessel. In an attempt
to avoid incorrect measurements, the ROIs were placed in the lower left corner [Fig. 4.1].
Figure 4.5 shows the continuing time series of Figure 4.4, with images captured 60, 90
and 120 minutes after injection. The large vessel beneath the plane has continued to
move relative to the CAM vasculature situated in the surface, making large changes in
the FOV compared to the 2-12 minute interval. Thus, it won’t be trustworthy to include
the images taken after 12 minutes in the calculations of the extravasation rate.
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Figure 4.5: PC3 #3) A continuation of the time series in Figure 4.4, from left to right: 60, 90 and 120
minutes after injection.

Time series: CAM with OHS

Figure 4.6 shows the time series from 2 to 12 minutes after injection of 40 kDa dextrans.
The CAM was inoculated with OHS at day 6, and the ROIs were measured according
to Figure 4.2. The structure of the vessels seems to be abnormal and chaotic, with
varying branching patterns. This indicates tumor development. By visual inspection,
the vasculature in the OHS CAM seems slightly more chaotic compared to the PC3
CAM in Figure 4.4. One can also see larger and more straight vessels in Figure 4.6.
These seems to be below the CAM vasculature, and are thus most likely normal vessels
situated in the chorion.

Figure 4.6: OHS #1) Time series showing the same CAM after injecting 40 kDa TMR into the vascula-
ture. The images are chronologically arranged, from left to right, by the time after injection and with a
2 minute interval between each image. The first image at the top left is taken 2 minutes after injection,
and the last image at the bottom right is taken 12 minutes after injection. The CAM was inoculated
with OHS cells at day 6, and the images were taken at day 14. The ROIs were measured in the positions
illustrated in Figure 4.2.

Figure 4.7 shows the continuing time series of Figure 4.6, with images captured 60, 90 and
120 minutes after injection. Compared to the 2-12 minute time series [Fig. 4.6], Figure
4.7 shows that more of the labeled dextrans have extravasated from the vasculature
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and into the EES. Even though there are large time gaps (30 minutes) between each
image in Figure 4.7, the images don’t seem to change that much, indicating that the
extravasation has slowed down. The intensity distribution in the EES is quite uneven,
with high intensities in the lower left and middle of the images, and low intensities in
the EES situated in the upper right. An explanation for this could be that changes have
happened in planes below, just like the large vessel moving beneath the CAM vasculature
in Figure 4.5.

Figure 4.7: OHS #1) A continuation of the time series in Figure 4.6, from left to right: 60, 90 and 120
minutes after injection.

Time series: Cancer free CAMs

Figure 4.8 shows the time series from 2 to 12 minutes after injection of 40 kDa dextrans.
The CAM was cancer free and the ROIs were measured according to Figure 4.3. The
structure of the vessels seems normal, with less chaotic and more straight vessels compared
to PC3 [Fig 4.1] and OHS [Fig. 4.2] illustrated earlier in this chapter. The vessels seems
to be distributed evenly through the whole FOV, by some long vessels with smaller and
organized branching patterns.
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Figure 4.8: Control #3) Time series showing the same CAM after injecting 40 kDa TRITC into the
vasculature. The images are chronologically arranged, from left to right, by the time after injection and
with a 2 minute interval between each image. The first image at the top left is taken 2 minutes after
injection, and the last image at the bottom right is taken 12 minutes after injection. The CAM was
cancer free and the images were taken at day 13. The ROIs were measured in the positions illustrated
in Figure 4.3.

Figure 4.9 shows the continuing time series of Figure 4.8, with images captured 60, 90 and
120 minutes after injection. Compared to the 2-12 minute time series [Fig. 4.6], Figure
4.7 shows that more of the labeled dextrans have extravasated from the vasculature and
into the EES. Figure 4.9 shows an increase in intensity in the upper part of the image
captured at 60 minutes after injection, compared to the images taken 90 and 120 minutes
after injection. This is due to changes in planes below the CAM, just like the large vessel
moving beneath the CAM vasculature in Figure 4.5.

Figure 4.9: Control #3) A continuation of the time series in Figure 4.8, from left to right: 60, 90 and
120 minutes after injection.

4.1.2 Smaller dextrans: 3-5 kDa FITC dextran

Representing the three groups PC3, OHS and control, a selection of CAMs injected with
labeled 3-5 kDa dextrans are presented in Figure 4.10-4.12. These also includes the
positioning of ROIs for the corresponding time series. All images included in this section,
were injected with 3-5 kDa FITC dextran and 2 MDa TMR dextran. The following
images show only the 3-5 kDa dextrans, using the FITC filter set.
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Figure 4.10: PC3 CAM #6) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of ROIs are shown as yellow circles.

Figure 4.11: OHS CAM #7) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of ROIs are shown as yellow circles.

Figure 4.12: Control CAM #9) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of ROIs are shown as yellow circles.
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Time series: CAMs with PC3

Figure 4.13 shows the time series from 2 to 12 minutes after injection of 3-5 kDa dextrans.
The CAM was inoculated with PC3 at day 6, and the ROIs were measured according to
Figure 4.10. The vessel structure is abnormal and chaotic, indicating tumor development.
Because of a lot of embryonic movement, the quality of the images is lowered. The
extravasation of fluorescent dextrans into the EES is clearly visible.

Figure 4.13: PC3 CAM #6) Time series showing the same CAM after injecting 3-5 kDa FITC into the
vasculature. The images are chronologically arranged, from left to right, by the time after injection and
with a 2 minute interval between each image. The first image at the top left is taken 2 minutes after
injection, and the last image at the bottom right is taken 12 minutes after injection. The CAM was
inoculated with PC3 cells at day 6, and the images were taken at day 13. The ROIs were measured in
the positions illustrated in Figure 4.10.

Figure 4.14 shows the continuing time series of Figure 4.13, with images captured 60, 90
and 120 minutes after injection. The vessels appear dark because most of the fluorescent
dextrans have extravasated into the EES. The dark vessels compared to the bright EES
could also have been caused by a spillage of labeled dextrans spreading through the FOV
after the 2-12 minute time series was captured.

Figure 4.14: PC3 #6) A continuation of the time series in Figure 4.13, from left to right: 60, 90 and 120
minutes after injection.
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Time series: CAMs with OHS

Figure 4.15 shows the time series from 2 to 12 minutes after injection of 3-5 kDa dextrans.
The CAM was inoculated with OHS at day 6, and the ROIs were measured according to
Figure 4.11. The vessel structure appears more normal than other cancer CAMs illus-
trated earlier in this chapter, thus there is a possibility that this CAM haven’t successfully
been developing cancer. However, the CAM is further assumed to have OHS cancer de-
velopment and is included in the calculations for finding the extravasation rate for the
OHS group. The extravasation of fluorescent dextrans into the EES is clearly visible.

Figure 4.15: OHS CAM #7) Time series showing the same CAM after injecting 3-5 kDa FITC into the
vasculature. The images are chronologically arranged, from left to right, by the time after injection and
with a 2 minute interval between each image. The first image at the top left is taken 2 minutes after
injection, and the last image at the bottom right is taken 12 minutes after injection. The CAM was
inoculated with OHS cells at day 6, and the images were taken at day 13. The ROIs were measured in
the positions illustrated in Figure 4.11.

Figure 4.16 shows an image of the same CAM presented in Figure 4.15, 60 minutes after
injection of fluorescent 3-5 kDa dextrans. The vessels appear dark because most of the
fluorescent dextrans have extravasated into the EES. A large, dark vessel is clearly visible
in the middle of the image. The vessel is situated in the chorion and was not visible in
Figure 4.15, and thus it must have moved, relative to the CAM vasculature, into the
FOV.
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Figure 4.16: OHS CAM #7) Image showing CAM "OHS #7" presented in Figure 4.15, 60 minutes after
injection of 3-5 kDa dextrans into the vasculature.

Time series: Cancer free CAMs

Figure 4.17 shows the time series from 2 to 12 minutes after injection of 3-5 kDa dextrans
into the vasculature. The CAM was cancer free and the ROIs were measured according
to Figure 4.12. The structure of the vessels seems normal, with less chaotic and more
straight vessels compared to tumor vasculature. The extravasation of fluorescent dextrans
into the EES is clearly visible, and appear to be higher than the extravasation shown for
PC3 and OHS in Figure 4.13 and 4.15. Because the embryo was very weak at 60 minutes
after injection, no longer time series were captured of the CAM.

Figure 4.17: Control CAM #9) Time series showing the same CAM after injecting 3-5 kDa FITC into
the vasculature. The images are chronologically arranged, from left to right, by the time after injection
and with a 2 minute interval between each image. The first image at the top left is taken 2 minutes
after injection, and the last image at the bottom right is taken 12 minutes after injection. The CAM
was cancer free and the images were taken at day. The ROIs were measured in the positions illustrated
in Figure 4.12.
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4.1.3 Extravasation rate

Two minutes after the injection, the dextran molecules were well distributed in the vascu-
lature, as seen in the presented figures above. The Patlak plots for PC3, OHS and control
are presented in Figure 4.18 and 4.19 for the two sizes of dextrans, 40 kDa TMR/TRITC
and 3-5 kDa FITC, respectively. Here, the ratio of the EES and intravascular fluorescence
intensity of the labeled dextrans, as a function of time, is plotted for the 2-12 minutes
time interval.

(a) Each curve represent one PC3-inoculated CAM. Curve
"PC3 #3" correspond to Figure 4.1 and 4.4

(b) Each curve represent one OHS-inoculated CAM.
Curve "OHS #1" correspond to Figure 4.2 and 4.6

(c) Each curve represent one cancer free CAM from the
control group. Curve "Control #3" correspond to Figure
4.3 and 4.8

Figure 4.18: Patlak plots for a) PC3, b) OHS and c) Control. The curves present the mean ratio of the
EES and intravascular fluorescence intensity of 40 kDa dextran (TMR or TRITC) as a function of time
after injection. The corresponding standard deviations and number of ROIs, are given in the plots.
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(a) Each curve represent one PC3-inoculated CAM. Curve
"PC3 #6" correspond to Figure 4.10 and 4.13

(b) Each curve represent one OHS-inoculated CAM.
Curve "OHS #7" correspond to Figure 4.11 and 4.15

(c) Each curve represent one cancer free CAM from the
control group. Curve "Control #9" correspond to Figure
4.12 and 4.17

Figure 4.19: Patlak plots for a) PC3, b) OHS and c) Control. The curves present the mean ratio of
the EES and intravascular fluorescence intensity of 3-5 kDa dextran (FITC) as a function of time after
injection. The corresponding standard deviations and number of ROIs, are given in the plots.

The extravasation rates of the two dextrans sizes were estimated by linear regression of
the terminal slope in Figure 4.18 and 4.19, including all the measurements from 4 to
12 minutes after injection. The first attempt to calculate the mean of the Ki for the
injections with 40 kDa dextrans, showed to give be much higher mean and standard
deviation for OHS compared to PC3 and control. By looking at Figure 4.18b the curve
labeled "OHS #4" clearly shows a steeper slope, i.e. higher Ki, than the rest. "OHS #4"
was consequently analyzed more in detail. The analysis can be found in Appendix B.
This led to the conclusion that the 40 kDa dextran vascular injection of CAM "OHS #4"
was unsuccessful. Some of the dextrans were spilled outside the vessels and had spread
everywhere, both in the intravascular space and in the EES. Hence, the measured Ki for
CAM "OHS #4" was removed from the calculation of the mean Ki for the OHS group.
Figure 4.20 shows the end result for the mean extravasation rate of 40 kDa dextrans, for
PC3, OHS and control. There were no significant differences between the Ki values of 40
kDa dextrans for the three groups.
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Figure 4.20: Mean extravasation rate of 40 kDa dextran. The plot shows the results for the three
groups PC3 (n=3), OHS (n=3) and control (n=5). The standard deviation is given for each bar. The
extravasation rate was found by the linear regression of the 4-12 minutes’ measurements given in Figure
4.18. The OHS measurement #4 is excluded to give a more true presentation. The p-values are included,
none of which differ significantly.

The mean extravasation rates of 3-5 kDa dextran are presented in Figure 4.21. The Ki

value of 3-5 kDa dextrans in the PC3 group showed to be significantly less than the Ki

found for the normal, control group.

Figure 4.21: Mean extravasation rate of 3-5 kDa dextran. The plot shows the results for the three
groups PC3 (n=3), OHS (n=4) and control (n=4). The standard deviation is given for each bar. The
extravasation rate was found by the linear regression of the 4-12 minutes’ measurements given in Figure
4.19. The p-values are included, where only PC3 and control differ significantly. Significant levels: *
p<0.05.

By visual comparison, the images of CAMs injected with 40 kDa dextrans [Section 4.1.1]
shows a lower extravasation rate than the CAMs injection of 3-5 kDa dextrans [Section
4.1.2]. A statistical comparison of the two dextran sizes is presented in Figure 4.22. A
high significant difference (p<0.01) between the extravasation rate of the two dextran
sizes was found within the OHS group. For the control CAMs, an even bigger significant
difference (p<0.0001) was found between the injection of 40 kDa and 3-5 kDa dextrans.
Even though the mean Ki for PC3 was found to be more than twice as high for the
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3-5 kDa dextrans compared to the 40 kDa dextrans, there was no significant difference
between PC3 CAMs injected with 40 kDa dextrans and PC3 CAMs injected with 3-5
kDa dextrans.

Figure 4.22: Comparison of Ki found for 40 kDa dextran [Fig. 4.20] and 3-5 kDa dextran [Fig. 4.21].
The p-values are included, where OHS and control differ significantly between the two dextran sizes.
Significant levels: ** p<0.01, **** p<0.0001.
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4.2 Microvascular Structure

In this section the results for vascular fraction, number of branching points and fractal
dimension are presented. For each of these analysis, a selection of nine images, three
from each group is shown to illustrate the end product of the image processing. It is the
same selection of images that is used for each of the analysis, and the original images are
shown in Figure 4.23.

(a) PC3. (b) OHS. (c) Control group.

Figure 4.23: CAMs (13-14 days old) showing the microvascular structure with a 25X magnification. The
figure is divided (vertically) in 3 groups; a) PC3, b) OHS and c) cancer free control group. The pixel
sizes were 2.5 × 2.5 µm2. a) Three PC3 inoculated CAMs. The top two were imaged using 2 MDa
FITC dextran. Because of trouble with extensive clustering of 2 MDa TMR dextrans, the bottom PC3
image is presented by showing the 3-5 kDa FITC dextrans, two minutes after injection. b) Three OHS
inoculated CAMs. The top two were imaged using 2 MDa FITC dextran. The bottom was imaged using
2 MDa TMR dextran. The white dots in the bottom image are clusters of the TMR dextran. c) Three
cancer free CAMs, all imaged using 2 MDa FITC dextran.
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4.2.1 Vascular fraction

The vascular fraction analysis was conducted on the whole image, or part of the image if
it contained very large blood vessels or parts of the plastic ring. Very large blood vessels
are often vessels that are not a part of the CAM vasculature, but are situated in the
chorion below. Figure 4.24 portray the processed images from Figure 4.23. These, and
all the other similarly processed images were used to calculate the mean vascular fraction.

(a) PC3. (b) OHS. (c) Control.

Figure 4.24: A selection of the vascular fraction analysis of a) PC3, b) OHS and c) control group. The
images were obtained using ImageJ (as described in Section 3.6.3) on an area of interest obtained from
the original images shown in Figure 4.23.

The mean vascular fraction for PC3, OHS and control are plotted in Figure 4.25. The
OHS group was estimated as significantly higher than the control group (p<0.01). No
other significant differences were found.

42



Chapter 4. Result 4.2 Microvascular Structure

Figure 4.25: The plot shows the mean vascular fraction for the three groups PC3 (n=7), OHS (n=11)
and control (n=10). The standard deviation is given for each bar. The analysis is conducted using
processed images as illustrated in Figure 4.24. Significant level: ** p<0.01.
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4.2.2 Branching points

The branching pattern was manually drawn in ImageJ. Since it was difficult and very
time consuming to avoid drawing junctions made by crossing vessels in the plane below,
the analyzed number of branching points include cross-paths between vessels crossing in
the planes below as well. Figure 4.26 portray the drawn branching pattern from Figure
4.23. These, and all the other drawn branching pattern were used to calculate the mean
number of branching points.

(a) PC3. (b) OHS. (c) Control.

Figure 4.26: A selection of the obtained branching patterns of a) PC3, b) OHS and c) control group.
The images were obtained using ImageJ on a chosen area of the original images shown in Figure 4.23.

The mean number of branching points (including crossing paths in planes below), for
PC3, OHS and control are plotted in Figure 4.27. Both PC3 (p<0.05) and OHS (p<0.01)
was estimated to have a significantly higher number of brancing points compared to the
control group. However, no significant differences was found between PC3 and OHS.
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Figure 4.27: Mean number of branching points, including crossing paths in the planes below. The
plot shows the results for the three groups PC3 (n=6), OHS (n=7) and control (n=10). The standard
deviation is given for each bar. The analysis is conducted using processed images as illustrated in Figure
4.26. Significant levels: * p<0.05, ** p<0.01.
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4.2.3 Fractal dimensions

The fractal dimension analysis was conducted on both outlined branching patterns and
skeletonized branching patterns. The images used to calculate the number of branching
points [Fig. 4.26] were also used as skeletonized branching patterns. Figure 4.28 portray
the processed, outlined images, derived from the vascular fraction images [Fig. 4.24].

(a) PC3 (b) OHS (c) Control.

Figure 4.28: A selection of the obtained outline of the vasculature of a) PC3, b) OHS and c) control
group. The images were obtained using ImageJ on images shown in Figure 4.24. The images were further
used in the ImageJ FracLac analysis, as described in Section 3.6.5, to find the fractal dimensions.

The mean fractal dimensions, for PC3, OHS and control, are plotted in Figure 4.29,
showing both the outlined and the skeletonized fractal dimensions. With the outlined
fractal dimension, only the OHS was estimated as significantly higher than the control
group (p<0.01). With the skeletonized fractal dimension, both PC3 (p<0.01) and OHS
(p<0.001) were estimated as significantly higher than the control group. However, no
significant differences was found between PC3 and OHS, in neither of the branching
patterns.
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(a) Db of outlined branching pattern. (b) Db of skeletonized branching pattern.

Figure 4.29: a) Mean, outlined fractal dimension. The plot shows the results for PC3 (n=7), OHS (n=11)
and control (n=10). b) Mean, skeletonized fractal dimension. The plot shows the results for the PC3
(n=6), OHS (n=7) and control (n=10). The standard deviation is given for each bar. Significant levels:
** p<0.01, *** p<0.001.

4.3 Correlations and Overview

Table 4.1: Overview over all the measured parameters, represented by mean and standard deviations.

PC3 OHS Control

Extravasation rate Ki

[10−4s−1], 40 kDa dextran 1.2944 ± 0.0788 1.3278 ± 0.2589a 1.1567 ± 0.1011b

Extravasation rate Ki

[10−4s−1], 3-5 kDa dextran 3.0333 ± 1.0171c 4.3041 ± 1.0963a 5.5333 ± 0.1381b,c

Vascular fraction 0.4041 ± 0.0089 0.4166 ± 0.0192d 0.3857 ± 0.0284d

No. of branching points [mm−2]
(including crossing paths) 31.45 ± 5.35e 34.19 ± 4.85f 25.38 ± 4.39e,f

Fractal dimension, outlined 1.7876 ± 0.0185 1.7922 ± 0.0173g 1.7701 ± 0.0120g

Fractal dimension, skeletonized 1.6096 ± 0.0254h 1.6300 ± 0.0211i 1.5671 ± 0.0338h,i

There are no significant differences between the two cancer groups PC3 and OHS. There are only
significant differences compared to the control group.
a,d,f,g,h ** Differ significantly with p<0.01.
b **** Differ significantly with p<0.0001.
c,e * Differ significantly with p<0.05.
i *** Differ significantly with p<0.001.

Table 4.1 gives an overview of all the estimated parameters, including extravasation
rate, vascular fraction, number of branching points and fractal dimensions. Those with
significant differences are marked. There are no significant differences between PC3 and
OHS. Table 4.1 shows a tendency where the OHS have the highest mean values and the
control have the lowest. OHS shows significantly higher values compared to control in
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all cases, except for the extravasation rate of 3-5 kDa dextran. PC3 shows significantly
higher values compared to control in the estimates on number of branching points and
the skeletonized fractal dimension. However, one parameter stands out, and that is the
extravasation rate of 3-5 kDa dextrans, where the control group have a significantly higher
Ki compared to PC3.

Correlation analysis were conducted on the extravasation rate and the microvascular
structural parameters. Figure 4.30 shows the correlations between the extravasation
rate of 40 kDa dextrans and the microvascular structure parameters: vascular fraction,
number of branching points and fractal dimensions. Only the relationship between the
Ki of 40 kDa dextrans and the outlined fractal dimension obtained a significant difference
(p=0.01), and thus showed a high degree of positive correlation. There were no tendencies
of correlations between the 3-5 kDa dextrans and the microvascular structural parameters.

(a) (b)

(c) (d)

Figure 4.30: Correlation analysis of the obtained mean Ki, for 40 kDa dextrans, and the mean microvas-
cular structural parameters: a) vascular fraction, b) number of branching points, c) outlined fractal
dimension and d) skeletonized fractal dimension. Standard deviations are given for each measurement.
Black circles represent OHS vasculature, gray circles represent PC3 vasculature and white circles repre-
sent control vasculature. The goodness of linear fit, R2, and p-values are given for each plot.

The correlation analysis comparing the microvascular structural parameters with each
other is shown in Figure 4.31. A tendency of correlation can be seen in all the plots in
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Figure 4.31, but only the relationship between the number of branching points and the
skeletonized fractal dimension obtained a significant difference (p=0.01), and thus showed
a high degree of positive correlation.

(a) (b)

(c) (d)

(e)

Figure 4.31: Correlation analysis between the obtained mean microvascular structural parameters: a and
b) vascular fraction vs. fractal dimensions, c and d) number of branching points vs. fractal dimensions,
and e) vascular fraction vs. number of branching points. Standard deviations are given for each mea-
surement. Black circles represent OHS vasculature, gray circles represent PC3 vasculature and white
circles represent control vasculature. The goodness of linear fit, R2, and p-values are given for each plot.
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Chapter 5: Discussion

5.1 Experimental challenges and success in cancer development

During the project, several improvements of the method were done. This includes using
PBS to avoid the imaging surface to dry out, medetomidine to avoid embryo movements
and changing the microscope lightguide. For the PC3 group, none of these improvements
were adopted yet. The five last CAMs in the OHS group (OHS CAMs labeled #2 and #3,
injected with 40 kDa dextrans and OHS CAMs labeled #6, #7 and #8, injected with 3-5
kDa dextran), were on the other hand imaged using both PBS and medetomidine, and the
last two in the OHS group (#7 and #8) were also imaged after changing the lightguide.
Only the CAMs in the control group were all imaged with PBS, medetomidine and a
changed lightguide. The usage of PBS to avoid drying, is of primary importance when
imaging a longer time series, thus it didn’t have any evident effects on the image quality
for the results presented in Chapter 4, which involved time series lasting 2-12 minutes.
The use of medetomidine, on the other hand, had a clear visual effect on the experiments,
by minimizing the embryonic movements, and are thus likely to have influenced some of
the results. The damaged lightguide could possibly have influenced the results as well.
The effects of medetomidine and changing lightguide are discussed later in this chapter.

Even though the control group gave lower mean values (not necessarily significantly dif-
ferent) for all the measured parameters, except Ki for 3-5 kDa dextran, the results were
still relatively high compared to PC3 and OHS. This could be related to the method.
Here the control group was, like the two cancer groups, gently traumatized at day 6 and
added a plastic ring. The traumatization gives an angiogenic response, and was done to
facilitate the inoculation of cancer cells. This might have had an effect on the structure
of the vessels imaged at day 13-14. However, the decision on giving all the groups the
same treatment was made to give a more true comparison between the groups. Vascular
fractions and fractal dimensions that are found in other studies done on normal control
CAMs, appear to be quite similar to the control results obtained here [28, 29] (will be
discussed more in Section 5.3 and 5.5). This indicates that the traumatization at day 6
might not have had an evident effect on the microvasculature at day 13-14. The CAMs
in our experiments appear to differ more from studies done on mice [26, 49], where the
difference between the two cancer types, and the difference between cancer and control,
appear to be larger. A more plausible explanation for the quite similar obtained values
for PC3, OHS and control in our experiments, is that the success rate for developing
cancer is lower than presumed. Not all the analyzed images of the PC3 and OHS groups
showed tortuous branching patterns, which is a known tumor vasculature characteristic.
Hence, the mean parameters of PC3 and OHS growing in CAM, is most likely slightly
underestimated, as cancer cells have failed to proliferate in some CAMs. There is also a
possibility that some of the ROIs were measuring the extravasation rate in normal vessels,
situated in between the chaotic tumor vasculature, which would decrease the mean Ki

values for tumor vasculature even more.
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5.2 Vascular permeability

The use of dextrans as molecular tracers has previously been used to study the blood
vessel permeability [26, 71, 72]. Dreher et al. [71] used dextrans of various sizes (3.3 kDa
to 2 MDa) to investigate the permeability in carcinoma tumors growing in dorsal window
chambers in mice. They found that increasing molecular weight of dextrans, significantly
reduced the molecule’s vascular permeability. The rate of accumulation of dextrans in
the tumor EES, was most rapid for dextrans with low molecular weights (less than 40
kDa), but such dextrans were also rapidly cleared again from the EES. The accumulation
of dextrans in the EES was found to be maximal for molecular weights between 40 and
70 kDa, but the high concentration was only observed approximately 15 µm from the
vessel wall. The small 3.3 kDa dextran, on the other hand, penetrated deeply (> 35 µm)
and homogeneously into the tumor tissue from the vessel wall. These results indicate
that the enhanced permeability effect is relevant for the chosen dextran sizes used in our
experiments (3-5 kDa and 40 kDa) as well.

The heterogeneity of tumor microvasculature gives, in general, rise to a high degree of
uncertainty in quantification of both structural parameters and permeability. This is the
case here as well, especially when it comes to quantifying the permeability by estimat-
ing the extravasation rate. The extravasation of 40 kDa dextran showed no significant
difference between the three groups. The volume transfer constant, Ktrans, describes the
transport of the small molecules between two compartments and can be used to indicate
the permeability of blood vessels. Ktrans is determined by Tofts’s model [73], which as-
sumes the tissue to be a two-compartment model consisting of a plasma compartment
and a EES compartment, where the rate constants from plasma to EES, and from EES to
plasma, are assumed to be identical. Ktrans is influenced by both vascular permeability
and perfusion. Sulheim et. al [49] used the Ktrans parameter to indicate the permeability
in tumors growing in mice, and found Ktrans to be approximately 2 times higher for OHS
compared to PC3. This is in agreement with the tendency of OHS having a higher mean
Ki than PC3, both for 3-5 kDa dextran (p=0.17) and 40 kDa dextran (p=0.85), which
can only be treated as an assumption since there were no significant differences.

Figure 4.22 shows, for both OHS and control, that the extravasation rate is significantly
higher for the small 3-5 kDa dextran compared to the larger 40 kDa dextran. This is
in agreement with the study on different dextran sizes by Dreher et al. [71]. However,
the PC3 group shows surprisingly, no significant difference between the extravasation of
40 kDa dextran and 3-5 kDa dextran. The main difference between PC3 and the other
groups [Fig. 4.22], causing p>0.05, is that PC3 gave a very low Ki for 3-5 kDa dextran,
which in fact is significantly lower (p<0.05) than the Ki found for the control group
[Fig. 4.21]. So, what could be the reason for PC3 in our experiments to have such a
low Ki for 3-5 kDa dextran compared to the other groups, when it appears to be quite
similar to OHS and control for the 40 kDa dextran extravasation. The ROIs used in
our experiments were circular, with diameter ranging from 25 µm to 50 µm. The ROIs
might thus have given a poor representation of the mean intensity values in the EES and
intravascular space. This, along with few experiments conducted on PC3 CAMs (n=3),
could consequently give an estimation of Ki which didn’t represent the real extravasation
rate. Perhaps the ROIs would give a better representation if they were to cover a wider
area, with the ROIs for the EES placed close to and along with the vessel wall. However,
there are differences between a tumor growing in mice and tumor growth in CAMs, which
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can affect the results. One very important difference to point out, is that mice have a
longer life span for experiments, allowing cancer to evolve to solid tumors. CAMs only
lasts for a short period (here: 14 days), resulting in a layer of developing tumor growth,
and not a defined solid tumor. This might have an influence on the IFP, which again
affects the EPR effect and the extravasation rate, and it might have a varying effect on
different cancer types. Thus, if a more similar model compared to tumors growing in mice
is wanted, it could be better to use tumor xenografts in the CAMs instead, to provide a
solid tumor.

It isn’t only the low extravasation of 3-5 kDa dextrans in PC3 that is worth discussing.
The vessel permeability in tumor tissue is known to be higher than for normal tissue
[35, 36, 37, 38], but the extravasation of 3-5 kDa dextrans for the control group, is
markedly higher [Fig. 4.21]. One explanation might be that one could assume from
Figure 4.21 that the 3-5 kDa dextran is significantly small compared to the permeability
of the vessels, independent of whether the vessels are situated in tumor growth or in
normal tissue. Hence the dextrans could leak through the vessels with a high rate in all
groups. However, one difference between tumor and normal tissue is the increased IFP in
tumor growth [43], as described in Section 2.2.3. Thus, the IFP will lower the EPR effect
and extravasation rate markedly in the two cancer groups, while the extravasation rate
in the control group won’t noteworthy be affected by the IFP, and stay high and stable
with low standard deviation (SD = ±0.14) [Table 4.1]. When the dextrans increases in
size to 40 kDa, the blood vessel permeability of the control group isn’t high enough to
give a high extravasation rate, and thus the low IFP in normal tissue won’t be enough to
allow the Ki of control to increase significantly relative to PC3 and OHS. So, at 40 kDa
dextran extravasation, none of the three groups differ significantly, since the vessels in
PC3 and OHS are more permeable, but experiences a higher IFP, while the control has
a normal IFP but is less permeable.

The use of medetomidine had a large impact on the quality of the images, and thus, on
the uncertainty in the post-imaging measurements as well. Obviously, less motion gives
sharper images, but it will also give a more true intensity distribution in the image. A
true detection of the intensity distribution, will give a more correct measurement of the
concentration of fluorescent tracers inside the blood vessels and in the EES. Whereas, a
blurry image can potentially increase the intensity in the EES and decrease the intensity
in the vessels, assuming a larger concentration of florescent tracers inside the vessels. In
addition, a blurry boarder between a vessel and EES due to motion, makes it difficult
to place the ROI at the correct distance from the vessel for each image in a time series.
Thus, motion can contribute to higher uncertainties in the measured extravasation rate.
An inhomogeneous illumination due to a damaged lightguide, gives decreasing intensities
in parts of the FOV and increasing in other. Figure 4.1 shows a very good example of
this. It is difficult to say how much this will affect the ratio of intensities measured in the
EES and in the vessels, which are further used to create the Patlak plot and find the Ki,
but it certainly has an effect on the overall intensity distribution. From Figure 4.20 and
4.21 in Section 4.1.3, the PC3 shows a high standard deviation for the extravasation of
3-5 kDa dextran, while the OHS shows a high standard deviation for 3-5 kDa dextran, in
addition to a relatively high standard deviation for 40 kDa dextran. The control group,
on the other hand, has a relatively low standard deviation for the 40 kDa dextran and
a very low standard deviation for the 3-5 kDa dextran. As described in Section 2.2.2
and 2.2.3, heterogeneity within tumor vasculature is expected, but some of the variations
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in the measurements are possibly affected by frequent embryonic motion in some of the
CAMs, and possibly by the damaged lightguide as well.

The medetomidine doesn’t necessarily only affect the image quality. It could also be that
medetomidine have had an effect on the blood vessel permeability. Since the extravasation
of 3-5 kDa dextran showed to be low for PC3 and very high for control, one might
think that medetomidine has increased the vessel permeability. Medetomidine have been
reported to cause significant peripheral vasoconstriction, where the blood vessels constrict
as result of contracting muscular vessel walls [74]. The vasoconstriction takes place in
vessels that have layers of smooth muscle cells, i.e. in the large arteries and veins and the
smaller arterioles and venules [75]. As a effect of vasoconstriction, the blood flow decreases
while the blood pressure increases in the constricted vessels [76]. In our experiments, the
analysis is based on the capillaries. Capillary walls consist only of endothelial cells and
a basal lamina [75], and will thus not be narrowed by the vasoconstriction, but the
increased blood pressure in the larger vessels may increase the pressure in the capillaries
as well, and hence make it more permeable as very high blood pressure could rupture
the fragile, thin-walled capillaries. Any possible effects medetomidine could have had on
the permeability in our experiments, can be investigated by looking at the OHS group.
The OHS group was imaged both with and without medetomidine. However, the Ki

values for the CAMs with medetomidine (OHS #2,#3 and #6-#8) didn’t show any clear
indications of increased extravasation compared to those without medetomidine (OHS
#1 and #5), in neither of the two dextran sizes (the measured Ki values for each CAM
is listed in Table C.2 and D.2, in Appendix C and D, respectively.).

5.3 Vascular fraction

PC3 tumors have been reported to have very low vascularity compared to many other
cancer types [21, 49]. Sulheim et al. found the PC3 in mice to have vessels mainly in
the periphery, while the OHS had a very high vascular density, with vessels more or less
throughout the whole tumor. Figure 2.8 and 2.9 by Sulheim et al. [49] in Section 2.2.5,
shows these measurements, where the mean vascular fraction in the outer 0.6 mm rim
of a tumor, is given as approximately 0.006 for PC3 and 0.017 OHS. This makes the
vascular fraction of OHS almost three times higher than PC3. Reitan et al. [26] found
the OHS tumors growing in dorsal window chambers in mice, to have a much higher
mean vascular fraction, at 0.21 (± 0.05 SD), twice as high as the vascular fraction, 0.10
(± 0.02 SD), found for the normal control tissue. From these results, one would perhaps
expect the vascular fractions obtained in our experiments to differ significantly as well,
but this is not entirely the case. The mean vascular fractions presented in Section 4.2.1,
are arranged in the order from high to low: OHS, PC3 and control, which is in consistency
with Sulheim et al. and Reitan et al. However, they appeared to be quite similar for all
three groups, with no significant difference between PC3 and OHS. However, with small
variations within each group, the vascular fraction of OHS and control obtained a high
significant difference, p < 0.01.

From Table 4.1, the mean vascular fractions, with standard deviations, are given as 0.4041
± 0.0089 for PC3 and 0.4166 ± 0.0192 for OHS. These are significantly higher results
compared to those obtained in mice by Sulheim et al. [49], and approximately twice as
high as what Reitan et al. estimated for the OHS tumors. The CAM is a very well
vascularized membrane, and one might assume it to have a larger vascular fraction, in
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general, compared to tumors growing in mice. Reizis et al. [77] studied the regional
and developmental variations of blood vessel morphometry in the CAM, and found the
vascular fraction of in ovo, cancer free CAMs at day 14 to be 0.400 (± 0.101 SD). This
fraction was measured in the area covering the air cell (formed at the blunt end of the egg
between the external and the internal eggshell membranes). Mancardi et al. investigated
the vascular network of CAMs as well [28], and found the vascular fraction of the control
group to be 0.37 (± 0.14 SD). These results support the fact that the estimated results in
our experiments are not excessively high, and that the CAM is a very well vascularized
membrane, independent on whether or not it has been given cancer.

5.4 Branching points

The number of branching points can say something about the vascular complexity. A
higher number of branching points indicates a more tortuous branching pattern [26],
which is common for tumor tissue [Fig. 2.6]. This correlates to the results obtained
in our experiments as well. Both PC3 (p<0.05) and OHS(p<0.01) showed significant
difference compared to the control group. OHS gave the highest number, but PC3 and
OHS did not differ significantly from each other. In the experiments on mice, by Reitan
et al. [26], the difference between OHS tumor tissue and control tissue was even bigger,
with the mean number of branching points for the OHS being over three times higher
than those found for the control group. As mentioned for the vascular fraction in the
section above, the CAM is a very well vascularized membrane, both in cancer tissue and
in normal tissue, and thus the number of branching points may be less different from
each other in our experiments compared to experiments done on mice.

5.5 Fractal dimension

Compared to vascular fraction, the fractal dimension has been reported, by Mancardi et
al. [28], to be a more robust estimator for CAM vasculature. In the study by Mancard
et al., only the fractal dimension was able to discriminate between effective and elusive
increase in vascularization, after drug-induced angiogenic stimulation on CAMs. From
experiments done on mice, Baish et al. [78] showed, by calculating fractal dimension,
that tumor vascular networks have a high vascular complexity, significantly different
from normal vasculature. In our experiments, the fractal dimension, Db, was calculated
for two types of branching patterns, outlined and skeletonized. The outlined pattern
showed the OHS to have the highest fractal dimension, followed by PC3, and then control.
However, only a significant difference was found between OHS and control (p<0.01) [Fig.
4.29a]. The skeletonized pattern gave the same arrangement between high and low fractal
dimensions, but led to larger differences between the groups, where both PC3 (p<0.01)
and OHS (p<0.001) showed high significant differences compared to the control group
[Fig. 4.29b]. From experience, the skeletonized pattern obtained in our experiments,
were thought to give a more comparable presentation of the fractal dimensions. This
is because the outlined vessel pattern [Fig. 4.28] gave a more uneven presentation of
the vessel walls compared to what seen in the original images [Fig. 4.23]. In addition,
the outlined pattern was very sensitive to motion, where some of the CAMs experienced
more motion than others. If there are blurry parts in the original image due to motion
or a thick cell layer, the outlined pattern gets blurry as well, i.e. the pattern gets more
chaotic. Hence, the fractal dimensions based on the outlines, are higher than the reality.
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Skeletonized patterns give, in general, a lower fractal dimension compared to outlined
patterns, as it neglects the difference in diameter of the branches [29]. Thus, skeletonized
images give a slightly lower fractal dimension than the reality. However, because of the
skeletonized pattern’s independence of high quality images with minimal motion, the
skeletonized images give a better Db for comparison in our experiments.

The Db estimated by Reitan et al. [26] in OHS tumors growing in mice was found to be
1.73 (± 0.05 SD), while for the control group it was found to be 1.58 (± 0.03 SD). The
conclusion is the same as in our experiments, with Db of OHS being significantly larger
than control. A study on fractal parameters in CAM, by Manera et al. [29], showed
that the mean Db for control CAMs was 1.733 (± 0.006 SD) at day 10. From both
these studies, one can trust the prior assumption that the fractal dimension based on the
outlined patterns gave too high value, and that the skeletonized patterns gave too low
value.

5.6 Correlation

A correlation analysis of the parameters for microvascular structural and blood vessel
permeability was conducted by Reitan et al.[26]. They found that an increase of ex-
travasation rate, for 40 kDa dextrans, correlated to an increase in both fractal dimension
and vascular fraction. The correlation analysis of permeability and microvascular struc-
ture conducted in this project [Fig. 4.30], showed a tendency of the same results, with
correlations between increasing vascular fraction, number of branching points and frac-
tal dimension, with increasing extravasation rate of 40 kDa dextran. However, only the
relationship between outlined fractal dimension and 40 kDa dextran extravasation rate,
obtained a significant correlation, with p = 0.01. Reitan et al. also found that an increase
in fractal dimension, correlated with an increase in both vascular fraction and number
of branching points. For the CAM assay in this project, the OHS showed significantly
higher values for all three parameters: vascular fraction, number of branching points and
fractal dimension, compared to the control group [Tabel 4.1], and is thus in agreement
with the reported correlation from Reitan et al. However, the correlation analysis of
our parameters for the microvascular structure [Fig. 4.31], showed only a significant cor-
relation between number of branching points and skeletonized fractal dimension, which
obtained a significant value p = 0.01.
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In this thesis, the chorioallantoic membrane model have been used to characterize and
compare the vasculature of PC3 and OHS, as well as comparing the cancer types with
normal control tissue. The characterization involved estimates of different parameters
related to blood vessel permeability and microvascular structure.

The characterization of permeability was conducted by measuring the vascular extrava-
sation rate of 40 kDa and 3-5 kDa dextrans. The estimated Ki of 40 kDa dextran showed
no significant difference between PC3, OHS and control. For the estimated Ki of 3-5 kDa
dextran, control obtained a significantly higher extravasation rate compared to PC3. By
comparing the estimated Ki of 40 kDa dextran with Ki of 3-5 kDa dextran, both OHS
and control showed to have significant higher extravasation rate of the smallest dextran.
PC3, on the other hand, showed no significant difference in extravasation rate between
the two dextran sizes.

The characterization of the microvascular structure was conducted by estimating vascu-
lar fraction, number of vascular branching points and fractal dimensions based on both
outlined and skeletonized patterns. OHS obtained significantly higher values in all the
structural parameters compared to the control group. This is in agreement with the the-
ory on tumor vasculature. PC3 showed a significantly higher number of branching points
and fractal dimension (based on skeletonized patterns), compared to the control group.
However, there were no significant differences in microvascular structure between PC3
and OHS.

A significant correlation was found between the extravasation rate of 40 kDa dextran and
the fractal dimension based on outlined branching patterns. The extravasation rate of
3-5 kDa dextran, on the other hand, showed no correlation with any of the estimated
parameters. Between the microvascular structural parameters, there was a significant
correlation between the number of vascular branching points and the fractal dimension
based on skeletonized branching patterns.

In conclusion, with this experimental method and image analysis, the CAM have not yet
proved to be a precise model to study differences in vascular permeability, compared to
for instance mice. In the characterization of microvascular structure, the model showed
more promising results, as OHS differed significantly from the control group in all the es-
timated parameters. However, the model could not separate OHS from PC3. In both the
characterization of permeability and microvascular structure, no significant differences
were obtained between PC3 and OHS, even though they are reported to have large differ-
ences in vascular density in tumors growing in mice[49]. With that said, the experimental
method is open for improvements, and thus future work might lead to better results.
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6.1 Future work

This thesis is a preliminary study of a bigger project, which will hopefully incorporate
the CAM model with ultrasound treatment, and allowing a study of ultrasound enhanced
delivery of drugs and nanoparticles. By evaluating the outcome of this project, a future
objective would be to use higher magnification in combination with applying medetomi-
dine to the CAM. For the Zeiss Axio Imager 2Z, the use of objective with 10x or higher
magnification, allows the use of apotome mode. By using apotome mode one will remove
the out-of-focus signals from planes above and below the focal plane, and thus giving a
better basis for imaging the vascular extravasation. Another objective will be to try the
apotome z-sectioning imaging, to crate 3D images.

Future work might also include a more thoroughly study on if, or how much, the medeto-
midine affects the vasculature. If one wants to continue to facilitate cancer development
by traumatizing the CAM vasculature, one should also consider to investigate any pos-
sible effects this may have on the vasculature. To better compare the CAM assay with
similar experiments done on mice, the use of tumor xenografts should be considered to
provide solid tumors. Solid tumors growing in CAMs would also be very interesting to
use when studying the effects of ultrasound treatment.

One last tip would be to use another type of 2 MDa dextran, than the 2 MDa tetram-
ethylrhodamine (Invitrogen, D7139) used in our experiments, as it was difficult to mix
homogeneously with the PBS, and thus usually created fluorescent clusters within the
blood vessels.

58



Bibliography

[1] Landbruks- og matdepartementet, gjelder for Norge, Forskift om bruk av dyr i forsøk,
2015. Available from Lovdata, https://lovdata.no/dokument/SF/forskrift/
2015-06-18-761#KAPITTEL_4.

[2] D. Ribatti, The Chick Embryo Chorioallantoic Membrane in the Study of Angiogen-
esis and Metastasis: The CAM assay in the study of angiogenesis and metastasis.
Springer Netherlands, 2010.

[3] D. Ribatti, “The chick embryo chorioallantoic membrane as a model for tumor biol-
ogy,” Experimental Cell Research, vol. 328, no. 2, pp. 314 – 324, 2014. Cell polarity.

[4] D. S. Dohle, S. D. Pasa, S. Gustmann, M. Laub, J. H. Wissler, H. P. Jennissen, and
N. Dünker, “Chick ex ovo culture and ex ovo cam assay: How it really works,” J Vis
Exp, p. e1620, 2009.

[5] P. Rous and J. Murphy, “Tumor implantations in the developing embryo,” J Am
Med Assoc, vol. 56, p. 741, 1911.

[6] J. B. Murphy, “Transplantability of tissues to the embryo of foreign species,” Journal
of Experimental Medicine, vol. 17, no. 4, pp. 482–493, 1913.

[7] M. A. Hill, “The gametes and fertilization,” in Embryology Book - The Early
Embryology of the Chick 2, University of New South Wales, 2012. Re-
trieved 01/12/2016, from https://embryology.med.unsw.edu.au/embryology/
index.php/Book_-_The_Early_Embryology_of_the_Chick_2.

[8] M. Duval, Etudes histologiques et morphologiques sur les annexes des embryons
d’oiseau. F. Alcan, 1884.

[9] Poultry Hub, Embryology of the chicken. Available at: http://www.
poultryhub.org/physiology/body-systems/embryology-of-the-chicken/; Ac-
cessed 23/11/2016.

[10] M. A. Hill, “Embryology book - the early embryology of the chick,” in
Extra-embryonic Membranes, University of New South Wales, 2012. Avail-
able at: https://embryology.med.unsw.edu.au/embryology/index.php/Book_
-_The_Early_Embryology_of_the_Chick_11; Accessed 01/12/2016.

[11] E. M. Janse and S. H. Jeurissen, “Ontogeny and function of two non-lymphoid cell
populations in the chicken embryo,” Immunobiology, vol. 182, no. 5, pp. 472–481,
1991.

[12] B. Janković, K. Isaković, M. Lukić, N. Vujanović, S. Petrović, and B. Marković, “Im-
munological capacity of the chicken embryo. i. relationship between the maturation
of lymphoid tissues and the occurrence of cell-mediated immunity in the developing
chicken embryo.,” Immunology, vol. 29, no. 3, p. 497, 1975.

[13] A. Vargas, M. Zeisser-Labouébe, N. Lange, R. Gurny, and F. Delie, “The chick

59

https://lovdata.no/dokument/SF/forskrift/2015-06-18-761#KAPITTEL_4
https://lovdata.no/dokument/SF/forskrift/2015-06-18-761#KAPITTEL_4
https://embryology.med.unsw.edu.au/embryology/index.php/Book_-_The_Early_Embryology_of_the_Chick_2
https://embryology.med.unsw.edu.au/embryology/index.php/Book_-_The_Early_Embryology_of_the_Chick_2
http://www.poultryhub.org/physiology/body-systems/embryology-of-the-chicken/
http://www.poultryhub.org/physiology/body-systems/embryology-of-the-chicken/
https://embryology.med.unsw.edu.au/embryology/index.php/Book_-_The_Early_Embryology_of_the_Chick_11
https://embryology.med.unsw.edu.au/embryology/index.php/Book_-_The_Early_Embryology_of_the_Chick_11


BIBLIOGRAPHY BIBLIOGRAPHY

embryo and its chorioallantoic membrane (cam) for the in vivo evaluation of drug
delivery systems,” Advanced Drug Delivery Reviews, vol. 59, no. 11, pp. 1162 – 1176,
2007. Prediction of Therapeutic and Drug Delivery Outcomes Using Animal Models.

[14] D. O. DeFouw, V. J. Rizzo, R. Steinfeld, and R. N. Feinberg, “Mapping of the
microcirculation in the chick chorioallantoic membrane during normal angiogenesis,”
Microvascular Research, vol. 38, no. 2, pp. 136 – 147, 1989.

[15] D. H. Ausprunk, D. R. Knighton, and J. Folkman, “Differentiation of vascular en-
dothelium in the chick chorioallantois: A structural and autoradiographic study,”
Developmental Biology, vol. 38, no. 2, pp. 237 – 248, 1974.

[16] T. S. Leeson and C. R. Leeson, “The chorio-allantois of the chick. light and electron
microscopic observations at various times of incubation,” J Anat, vol. 97, pp. 585–
595, Oct 1963. 14064101[pmid].

[17] G. Ottaviani and N. Jaffe, The Epidemiology of Osteosarcoma, pp. 3–13. Boston,
MA: Springer US, 2010.

[18] National Cancer Institute, An interactive tool for access to SEER cancer statistics.
Surveillance Research Program, National Cancer Institute, Fast Stats: An interactive
tool for access to SEER cancer statistics, 2017. Available at: https://seer.cancer.
gov/faststats; Accessed 19/04/2017.

[19] American Cancer Society, Atlanta: American Cancer Society, Can-
cer Facts & Figures 2017, 2017. Available at: https://www.cancer.
org/content/dam/cancer-org/research/cancer-facts-and-statistics/
annual-cancer-facts-and-figures/2017/cancer-facts-and-figures-2017.
pdf; Accessed 19/04/2017.

[20] J. Hardin, G. P. Bertoni, and L. J. Kleinsmith, Becker’s World of the Cell. Pearson
Higher Ed, 8 ed., 2012.

[21] K. Zhang and D. J. Waxman, “Impact of tumor vascularity on responsiveness to
anti-angiogenesis in a prostate cancer stem cell-derived tumor model,” Mol Cancer
Ther, vol. 12, pp. 10.1158/1535–7163.MCT–12–1240, May 2013. 23635653[pmid].

[22] N. Nishida, H. Yano, T. Nishida, T. Kamura, and M. Kojiro, “Angiogenesis in can-
cer,” Vasc Health Risk Manag, vol. 2, pp. 213–219, Sep 2006. 17326328[pmid].

[23] M. Szkudlarek, R. M. Bosio, Q. Wu, and K.-V. Chin, “Inhibition of angiogenesis by
extracellular protein kinase a,” Cancer Letters, vol. 283, no. 1, pp. 68 – 73, 2009.

[24] D. Hanahan and J. Folkman, “Patterns and emerging mechanisms of the angiogenic
switch during tumorigenesis,” Cell, vol. 86, no. 3, pp. 353 – 364, 1996.

[25] J. A. Nagy, S.-H. Chang, S.-C. Shih, A. M. Dvorak, and H. F. Dvorak, “Heterogeneity
of the tumor vasculature,” Semin Thromb Hemost, vol. 36, pp. 321–331, Apr 2010.
20490982[pmid].

[26] N. K. Reitan, M. Thuen, P. E. Goa, and C. de Lange Davies, “Characterization
of tumor microvascular structure and permeability: comparison between magnetic
resonance imaging and intravital confocal imaging,” Journal of biomedical optics,
vol. 15, no. 3, pp. 036004–036004, 2010.

60

https://seer.cancer.gov/faststats
https://seer.cancer.gov/faststats
https://www.cancer.org/content/dam/cancer-org/research/cancer-facts-and-statistics/annual-cancer-facts-and-figures/2017/cancer-facts-and-figures-2017.pdf
https://www.cancer.org/content/dam/cancer-org/research/cancer-facts-and-statistics/annual-cancer-facts-and-figures/2017/cancer-facts-and-figures-2017.pdf
https://www.cancer.org/content/dam/cancer-org/research/cancer-facts-and-statistics/annual-cancer-facts-and-figures/2017/cancer-facts-and-figures-2017.pdf
https://www.cancer.org/content/dam/cancer-org/research/cancer-facts-and-statistics/annual-cancer-facts-and-figures/2017/cancer-facts-and-figures-2017.pdf


BIBLIOGRAPHY BIBLIOGRAPHY

[27] J. W. Baish and R. K. Jain, “Fractals and cancer,” Cancer research, vol. 60, no. 14,
pp. 3683–3688, 2000.

[28] D. Mancardi, G. Varetto, E. Bucci, F. Maniero, and C. Guiot, “Fractal parameters
and vascular networks: facts & artifacts,” Theoretical Biology and Medical Modelling,
vol. 5, no. 1, p. 12, 2008.

[29] M. Manera, L. Giari, J. Depasquale, and B. Dezfuli, “European sea bass gill pathol-
ogy after exposure to cadmium and terbuthylazine: expert versus fractal analysis,”
Journal of microscopy, vol. 261, no. 3, pp. 291–299, 2016.

[30] E. Sabo, A. Boltenko, Y. Sova, A. Stein, S. Kleinhaus, and M. B. Resnick, “Mi-
croscopic analysis and significance of vascular architectural complexity in renal cell
carcinoma,” Clinical Cancer Research, vol. 7, no. 3, pp. 533–537, 2001.

[31] J. M. Brown, “Tumor hypoxia in cancer therapy,” Methods in enzymology, vol. 435,
pp. 295–321, 2007.

[32] M. I. Lin and W. C. Sessa, “Antiangiogenic therapy: Creating a unique window of
opportunity,” Cancer Cell, vol. 6, no. 6, pp. 529 – 531, 2004.

[33] E. Scribner, O. Saut, P. Province, A. Bag, T. Colin, and H. M. Fathallah-Shaykh,
“Effects of anti-angiogenesis on glioblastoma growth and migration: model to clinical
predictions,” PloS one, vol. 9, no. 12, p. e115018, 2014.

[34] R. K. Jain, “Determinants of tumor blood flow: a review,” Cancer research, vol. 48,
no. 10, pp. 2641–2658, 1988.

[35] D. Fukumura and R. K. Jain, “Tumor microenvironment abnormalities: Causes, con-
sequences, and strategies to normalize,” Journal of Cellular Biochemistry, vol. 101,
no. 4, pp. 937–949, 2007.

[36] F. Yuan, M. Dellian, D. Fukumura, M. Leunig, D. A. Berk, V. P. Torchilin, and
R. K. Jain, “Vascular permeability in a human tumor xenograft: Molecular size
dependence and cutoff size,” Cancer Research, vol. 55, no. 17, pp. 3752–3756, 1995.

[37] F. Yuan, M. Leunig, D. A. Berk, and R. K. Jain, “Microvascular permeability of
albumin, vascular surface area, and vascular volume measured in human adenocar-
cinoma {LS174T} using dorsal chamber in {SCID} mice,” Microvascular Research,
vol. 45, no. 3, pp. 269 – 289, 1993.

[38] R. K. Jain, “Transport of molecules across tumor vasculature,” Cancer and Metas-
tasis Reviews, vol. 6, no. 4, pp. 559–593, 1987.

[39] S. K. Hobbs, W. L. Monsky, F. Yuan, W. G. Roberts, L. Griffith, V. P. Torchilin, and
R. K. Jain, “Regulation of transport pathways in tumor vessels: role of tumor type
and microenvironment,” Proceedings of the National Academy of Sciences, vol. 95,
no. 8, pp. 4607–4612, 1998.

[40] J. W. Nichols and Y. H. Bae, “Epr: Evidence and fallacy,” Journal of Controlled
Release, vol. 190, pp. 451 – 464, 2014. 30th Anniversary Special Issue.

[41] B. Theek, M. Baues, T. Ojha, D. Möckel, S. K. Veettil, J. Steitz, L. van Bloois,
G. Storm, F. Kiessling, and T. Lammers, “Sonoporation enhances liposome accumu-
lation and penetration in tumors with low {EPR},” Journal of Controlled Release,

61



BIBLIOGRAPHY BIBLIOGRAPHY

vol. 231, pp. 77 – 85, 2016. Thirteenth International Nanomedicine and Drug Deliv-
ery Symposium.

[42] S. Wilhelm, A. J. Tavares, Q. Dai, S. Ohta, J. Audet, H. F. Dvorak, and W. C.
Chan, “Analysis of nanoparticle delivery to tumours,” Nature Reviews Materials,
vol. 1, p. 16014, 2016.

[43] C.-H. Heldin, K. Rubin, K. Pietras, and A. Östman, “High interstitial fluid pres-
sure—an obstacle in cancer therapy,” Nature Reviews Cancer, vol. 4, no. 10, pp. 806–
813, 2004.

[44] J. Ferlay, I. Soerjomataram, R. Dikshit, S. Eser, C. Mathers, M. Rebelo, D. M.
Parkin, D. Forman, and F. Bray, “Cancer incidence and mortality worldwide:
Sources, methods and major patterns in globocan 2012,” International Journal of
Cancer, vol. 136, no. 5, pp. E359–E386, 2015.

[45] E. J. Hall and A. J. Giaccia, Radiobiology for the Radiologist. Lippincott Williams
& Wilkins, 7 ed., 2012.

[46] J. Ferlay, I. Soerjomataram, M. Ervik, R. Dikshit, S. Eser, C. Mathers, M. Rebelo,
D. Parkin, D. Forman, and F. Bray, “Cancer Incidence and Mortality Worldwide:
IARC CancerBase No. 11,” 2013. GLOBOCAN 2012 v1.0. Lyon, France: Interna-
tional Agency for Research on Cancer. Available from: http://globocan.iarc.fr;
Accessed 20/10/2016.

[47] A. T. Collins, P. A. Berry, C. Hyde, M. J. Stower, and N. J. Maitland, “Prospective
identification of tumorigenic prostate cancer stem cells,” Cancer Research, vol. 65,
no. 23, pp. 10946–10951, 2005.

[48] S. Varambally, S. M. Dhanasekaran, M. Zhou, T. R. Barrette, C. Kumar-Sinha,
M. G. Sanda, D. Ghosh, K. J. Pienta, R. G. A. B. Sewalt, A. P. Otte, M. A. Rubin,
and A. M. Chinnaiyan, “The polycomb group protein ezh2 is involved in progression
of prostate cancer,” Nature, vol. 419, pp. 624–629, Oct 2002.

[49] E. Sulheim, J. Kim, A. van Wamel, E. Kim, S. Snipstad, I. Vidic, M. Widerøe, D. J.
Waxman, S. H. Torp, S. Lundgren, and C. del Davies, “Multi-modal characterization
of vasculature and nanoparticle accumulation in five tumor xenograft models.” Yet
to be published.

[50] National Cancer Institute, What Is Cancer?, 2015. Available at: https://www.
cancer.gov/publishedcontent/syndication/13704.htm; Accessed 03/05/2017.

[51] PDQ® Pediatric Treatment Editorial Board, PDQ Osteosarcoma and Malignant Fi-
brous Histiocytoma of Bone Treatment, 2017. Bethesda, MD: National Cancer Insti-
tute. Updated 15/05/2017. Available at: https://www.cancer.gov/types/bone/
patient/osteosarcoma-treatment-pdq. Accessed 11/06/2017. [PMID: 26389380].

[52] Ø. Fodstad, A. Brøgger, Ø. Bruland, Ø. P. Solheim, J. M. Nesland, and A. Pihl,
“Characteristics of a cell line established from a patient with multiple osteosarcoma,
appearing 13 years after treatment for bilateral retinoblastoma,” International jour-
nal of cancer, vol. 38, no. 1, pp. 33–40, 1986.

[53] A. E. Hansen, A. L. Petersen, J. R. Henriksen, B. Boerresen, P. Rasmussen, D. R. El-
ema, P. M. a. Rosenschöld, A. T. Kristensen, A. Kjær, and T. L. Andresen, “Positron

62

http://globocan.iarc.fr
https://www.cancer.gov/publishedcontent/syndication/13704.htm
https://www.cancer.gov/publishedcontent/syndication/13704.htm
https://www.cancer.gov/types/bone/patient/osteosarcoma-treatment-pdq
https://www.cancer.gov/types/bone/patient/osteosarcoma-treatment-pdq


BIBLIOGRAPHY BIBLIOGRAPHY

emission tomography based elucidation of the enhanced permeability and retention
effect in dogs with cancer using copper-64 liposomes,” ACS Nano, vol. 9, no. 7,
pp. 6985–6995, 2015. PMID: 26022907.

[54] Carl Zeiss, Axio Imager 2 - Progress Meets Performance, 2009. http://www.
ks-micro.ru/Axio%20Imager%202.pdf.

[55] Robarts Research Institute, Apotome Training Manual, 2014. Available at: http:
//www.robarts.ca/confocal/Apotome%20july2014.pdf. Accessed 15/06/2017.

[56] D. B. Murphy and M. W. Davidson, “Chapter 11, fluorescence microscopy,” in Fun-
damentals of light microscopy and electronic imaging, John Wiley & Sons, 2013.

[57] I. Bye, “Study of tumor angiogenesis using the chicken chorioallantoic membrane
model,” 2016. Specialization project at NTNU - Unpublished.

[58] Termo Fisher, Dextran Conjugates, 2006. Catalog Number MP 01800. Man-
uals and protocols: https://tools.thermofisher.com/content/sfs/manuals/
mp01800.pdf.

[59] Sigma-Aldrich, Tetramethylrhodamine isothiocyanate–Dextran, 2017. Specification
Sheet: http://www.sigmaaldrich.com/catalog/DataSheetPage.do?brandKey=
SIGMA&symbol=42874.

[60] Carl Zeiss, Filter Assistant: Filter Set 43 HE. Available at: https:
//www.micro-shop.zeiss.com/?s=78965505e00ceb&l=en&p=us&f=f&a=v&b=
f&id=489043-9901-000&o=.

[61] Sigma-Aldrich, Fluorescein Isothiocyanate-Dextran Sigma Stock Nos. FD-
4, FD-10S, FD-20S, FD-20, FD-40S, FD-40, FD-70S, FD-70, FD-150S,
FD-150, FD-250S, FD-500S, and FD-2000S, 1997. Product Information:
http://www.sigmaaldrich.com/content/dam/sigma-aldrich/docs/Sigma/
Product_Information_Sheet/1/fd2000spis.pdf.

[62] Carl Zeiss, Filter Assistant: Filter Set 38 HE. Available at: https:
//www.micro-shop.zeiss.com/?s=78965505e00ceb&l=en&p=us&f=f&a=v&b=
f&id=489038-9901-000&o=.

[63] W. Bailer, “Writing imagej plugins—a tutorial,” Upper Austria University of Applied
Sciences, Austria, 2006.

[64] C. Igathinathane, L. Pordesimo, E. P. Columbus, W. D. Batchelor, and
S. Sokhansanj, “Sieveless particle size distribution analysis of particulate materi-
als through computer vision,” Computers and Electronics in Agriculture, vol. 66,
no. 2, pp. 147–158, 2009.

[65] J. W. Baish, Y. Gazit, D. A. Berk, M. Nozue, L. T. Baxter, and R. K. Jain, “Role of
tumor vascular architecture in nutrient and drug delivery: An invasion percolation-
based network model,” Microvascular Research, vol. 51, no. 3, pp. 327 – 346, 1996.

[66] C. S. Patlak, R. G. Blasberg, and J. D. Fenstermacher, “Graphical evaluation of
blood-to-brain transfer constants from multiple-time uptake data,” Journal of Cere-
bral Blood Flow & Metabolism, vol. 3, no. 1, pp. 1–7, 1983. PMID: 6822610.

63

http://www.ks-micro.ru/Axio%20Imager%202.pdf
http://www.ks-micro.ru/Axio%20Imager%202.pdf
http://www.robarts.ca/confocal/Apotome%20july2014.pdf
http://www.robarts.ca/confocal/Apotome%20july2014.pdf
https://tools.thermofisher.com/content/sfs/manuals/mp01800.pdf
https://tools.thermofisher.com/content/sfs/manuals/mp01800.pdf
http://www.sigmaaldrich.com/catalog/DataSheetPage.do?brandKey=SIGMA&symbol=42874
http://www.sigmaaldrich.com/catalog/DataSheetPage.do?brandKey=SIGMA&symbol=42874
https://www.micro-shop.zeiss.com/?s=78965505e00ceb&l=en&p=us&f=f&a=v&b=f&id=489043-9901-000&o=
https://www.micro-shop.zeiss.com/?s=78965505e00ceb&l=en&p=us&f=f&a=v&b=f&id=489043-9901-000&o=
https://www.micro-shop.zeiss.com/?s=78965505e00ceb&l=en&p=us&f=f&a=v&b=f&id=489043-9901-000&o=
http://www.sigmaaldrich.com/content/dam/sigma-aldrich/docs/Sigma/Product_Information_Sheet/1/fd2000spis.pdf
http://www.sigmaaldrich.com/content/dam/sigma-aldrich/docs/Sigma/Product_Information_Sheet/1/fd2000spis.pdf
https://www.micro-shop.zeiss.com/?s=78965505e00ceb&l=en&p=us&f=f&a=v&b=f&id=489038-9901-000&o=
https://www.micro-shop.zeiss.com/?s=78965505e00ceb&l=en&p=us&f=f&a=v&b=f&id=489038-9901-000&o=
https://www.micro-shop.zeiss.com/?s=78965505e00ceb&l=en&p=us&f=f&a=v&b=f&id=489038-9901-000&o=


BIBLIOGRAPHY BIBLIOGRAPHY

[67] C. C. Reyes-Aldasoro, I. Wilson, V. E. Prise, P. R. Barber, M. Ameer-Beg, B. Vo-
jnovic, V. J. Cunningham, and G. M. Tozer, “Estimation of apparent tumor vascular
permeability from multiphoton fluorescence microscopic images of p22 rat sarcomas
in vivo.,” Microcirculation, vol. 15, no. 1, pp. 65 – 79, 2008.

[68] W. Orem, “Why You Should Store Your Eggs Fat End Up,” 2016. Available at:
http://indianapublicmedia.org/amomentofscience/keep-your-fat-end-up/;
Accessed 23/10/2016.

[69] Sigma-Aldrich, ECM gel from Engelbreth-Holm-Swarm mouse sarcoma, 2001. Cat-
alog Number E1270. Datasheet: https://www.sigmaaldrich.com/content/dam/
sigma-aldrich/docs/Sigma/Datasheet/3/e1270dat.pdf.

[70] C. Waschkies, F. Nicholls, and J. Buschmann, “Comparison of medetomidine,
thiopental and ketamine/midazolam anesthesia in chick embryos for in ovo mag-
netic resonance imaging free of motion artifacts,” Scientific Reports, vol. 5, p. 15536
EP, Oct 2015. Article.

[71] M. R. Dreher, W. Liu, C. R. Michelich, M. W. Dewhirst, F. Yuan, and A. Chilkoti,
“Tumor vascular permeability, accumulation, and penetration of macromolecular
drug carriers,” JNCI: Journal of the National Cancer Institute, vol. 98, no. 5, p. 335,
2006.

[72] C. C. Reyes-Aldasoro, I. Wilson, V. E. Prise, P. R. Barber, M. Ameer-Beg, B. Vo-
jnovic, V. J. Cunningham, and G. M. Tozer, “Estimation of apparent tumor vascular
permeability from multiphoton fluorescence microscopic images of p22 rat sarcomas
in vivo,” Microcirculation, vol. 15, no. 1, pp. 65–79, 2008.

[73] P. S. Tofts, G. Brix, D. L. Buckley, J. L. Evelhoch, E. Henderson, M. V. Knopp, H. B.
Larsson, T.-Y. Lee, N. A. Mayr, G. J. Parker, et al., “Estimating kinetic parameters
from dynamic contrast-enhanced t 1-weighted mri of a diffusable tracer: standardized
quantities and symbols,” Journal of Magnetic Resonance Imaging, vol. 10, no. 3,
pp. 223–232, 1999.

[74] M. Tear, Small animal surgical nursing. Elsevier Health Sciences, 2014.

[75] B. Alberts, A. Johnson, J. Lewis, P. Walter, M. Raff, and K. Roberts, “Molecular
biology of the cell 4th edition: International student edition,” 2002.

[76] OpenStax, Structure and Function of Blood Vessels, 2013. Open-
Stax CNX. 28. June 2013. Available at: http://cnx.org/contents/
58db2cce-b3d9-4904-9049-80a6cd89264b@4. Accessed 17/06/2017.

[77] A. Reizis, I. Hammel, and A. Ar, “Regional and developmental variations of blood
vessel morphometry in the chick embryo chorioallantoic membrane,” Journal of Ex-
perimental Biology, vol. 208, no. 13, pp. 2483–2488, 2005.

[78] Y. Gazit, J. W. Baish, N. Safabakhsh, M. Leunig, L. T. Baxter, and R. K. Jain,
“Fractal characteristics of tumor vascular architecture during tumor growth and
regression,” Microcirculation, vol. 4, no. 4, pp. 395–402, 1997.

[79] K. G. Sæterbø, Tining, dyrking og frysing av PC3, 2012. Institutt for fysikk. Bio-
fysikk og medisinsk teknologi. Kvalitetshåndbok. Document code MT-520.

64

http://indianapublicmedia.org/amomentofscience/keep-your-fat-end-up/
https://www.sigmaaldrich.com/content/dam/sigma-aldrich/docs/Sigma/Datasheet/3/e1270dat.pdf
https://www.sigmaaldrich.com/content/dam/sigma-aldrich/docs/Sigma/Datasheet/3/e1270dat.pdf
http://cnx.org/contents/58db2cce-b3d9-4904-9049-80a6cd89264b@4
http://cnx.org/contents/58db2cce-b3d9-4904-9049-80a6cd89264b@4


BIBLIOGRAPHY BIBLIOGRAPHY

[80] K. G. Sæterbø, Dyrking av OHS, 2009. Institutt for fysikk. Biofysikk og medisinsk
teknologi. Kvalitetshåndbok. Document code MT-501.

[81] K. G. Sæterbø, Telling av celler i burker kammer, 2009. Institutt for fysikk. Biofysikk
og medisinsk teknologi. Kvalitetshåndbok. Document code MT-506.

65



Appendix A: Embryo Development

       
            Day 3      Day 4 

        
                    Day 5      Day 6    

        
              Day 7       Day 8 

Figure A.1: Embryo development from egg is cracked, at day 3, and until day 8 [57].
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Chapter A. Embryo Development

        
            Day 9       Day 10 

        
           Day 11       Day 12        

        
           Day 13        Day 14 

Figure A.2: Continued embryo development from day 9 and until day 14. At the age of
14 days, all embryos was sacrificed. The images are retrieved from the prior specialization
project conducted in the fall 2016 [57].
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Appendix B: Correction of Ki in CAM with
OHS

This appendix present the correction of the extravasation rate, Ki, for group OHS, in-
jected with 40 kDa dextrans. The 40 kDa TMR/TRITC dextran injection was mixed
with 2 MDa FITC dextran, as described in Section 3.4, which can be visualized by chang-
ing the filter set. The 2 MDa dextran molecules are significantly larger than the 40 kDa,
and thus one should not expect evident leakage of the 2 MDA dextrans from the blood
vessels. The ratio of the EES and intravascular fluorescence intensity of 2 MDa FITC
dextran molecules was calculated for the "OHS #4" CAM at 12 and 120 minutes after
injection. A similar calculation was done for the "OHS #1" for comparison. Figure B.1
presents these results. It shows a clear increase in extravasation of 2 MDa dextrans in
CAM "OHS #4" [Fig. B.1d] compared to "OHS #1" [Fig. B.1b], which actually shows a
minor decrease. Since the EES and intravascular fluorescence intensities shouldn’t change
noteworthy for dextrans too large to take part in the extravasation, Figure B.1 support
the decision of removing CAM "OHS #4" from the mean Ki estimations for the OHS
group. The explanation for the large amount of 2 MDa FITC dextrans in the EES in
the "OHS #4" time series, is that the injection of labeled dextrans wasn’t good enough.
A significant amount have been injected outside the vessels as well, which consequently
have spread throughout the whole FOV. Figure B.2 shows the mean and SD for the three
groups when CAM "OHS #4" is still included.

(a)
(b)

(c)
(d)

Figure B.1: a) and c) Vessels visualized by injection of 2 MDa FITC dextran. Left) 12 minutes after
injection. Right) 120 minutes after injection. b) The ratio of the EES and intravascular fluorescence
intensity of 2 MDa FITC dextran molecules measured in a). The ratio doesn’t change significantly
between 12 and 120 minutes. Which is expected for such large dextrans. d) The ratio of the EES and
intravascular fluorescence intensity of 2 MDa FITC dextran molecules measured in c) The ratio changes
significantly between 12 and 120 minutes. This is unexpected for such large dextrans, and thus it is
believed that some of the injection was spilled outside the vessels.
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Chapter B. Correction of Ki in CAM with OHS

Figure B.2: Mean extravasation rate of 40 kDa dextran. The plot shows the results for the three
groups PC3 (n=3), OHS (n=4) and control (n=5). The standard deviation is given for each bar. The
extravasation rate was found by the linear regression of the 4-12 minutes’ measurements given in Figure
4.18. The p-values are included, none of which differ significantly.
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Appendix C: Time series images: –
40 kDa TMR/TRITC

All obtained time series used to calculate the extravasation rate of 40 kDa TMR and
TRITC for the three groups PC3, OHS and control. Ki for each CAM is included in
Table C.1, C.2 and C.3.

C.1 PC3

Figure C.1: PC3 CAM #1) Image of CAM 2 minutes after injection of 40 kDa TMR dextran. The
positions of measured ROIs are shown as yellow circles.

Figure C.2: PC3 CAM #1) Images from the same CAM showing the injected 40 kDa TMR. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was inoculated with PC3 cells at day 6, and the images
were taken at 13. The ROIs were measured in the positions illustrated in Figure C.1
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C.1 PC3
Chapter C. Time series images:

– 40 kDa TMR/TRITC

Figure C.3: PC3 #2) Image of CAM 2 minutes after injection of 40 kDa TMR dextran. The positions
of measured ROIs are shown as yellow circles.

Figure C.4: PC3 #2) Images from the same CAM showing the injected 40 kDa TMR. The images are
chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was inoculated with PC3 cells at day 6, and the images
were taken at 13. The ROIs were measured in the positions illustrated in Figure C.3

Figure C.5: PC3 #2) A continuation of the time series in Figure C.4, from left to right: 60, 90 and 120
minutes after injection.
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Chapter C. Time series images:
– 40 kDa TMR/TRITC C.1 PC3

Figure C.6: PC3 #3) Image of CAM 2 minutes after injection of 40 kDa TMR dextran. The positions
of measured ROIs are shown as yellow circles.

Figure C.7: PC3 3) Images from the same CAM showing the injected 40 kDa TMR. The images are
chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was inoculated with PC3 cells at day 6, and the images
were taken at 13. The ROIs were measured in the positions illustrated in Figure C.6.

Figure C.8: PC3 #3) A continuation of the time series in Figure C.7, from left to right: 60, 90 and 120
minutes after injection.
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C.2 OHS
Chapter C. Time series images:

– 40 kDa TMR/TRITC

C.2 OHS

Figure C.9: OHS #1) Image of OHS inoculated CAM 2 minutes after injection of 40 kDa TMR dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.10: OHS #1) Images from the same CAM showing the injected 40 kDa TMR. The images are
chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was inoculated with OHS cells at day 6, and the images
were taken at day 14. The ROIs were measured in the positions illustrated in Figure C.9.

Figure C.11: OHS #1) A continuation of the time series in Figure C.10, from left to right: 60, 90 and
120 minutes after injection.
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Chapter C. Time series images:
– 40 kDa TMR/TRITC C.2 OHS

Figure C.12: OHS #2) Image of OHS inoculated CAM 2 minutes after injection of 40 kDa TMR dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.13: OHS #2) Images from the same CAM showing the injected 40 kDa TMR. The images are
chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was inoculated with OHS cells at day 6, and the images
were taken at day 14. The ROIs were measured in the positions illustrated in Figure C.12.
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C.2 OHS
Chapter C. Time series images:

– 40 kDa TMR/TRITC

Figure C.14: OHS #3) Image of OHS inoculated CAM 2 minutes after injection of 40 kDa TMR dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.15: OHS #3) Images from the same CAM showing the injected 40 kDa TMR. The images are
chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was inoculated with OHS cells at day 6, and the images
were taken at day 14. The ROIs were measured in the positions illustrated in Figure C.14.

Figure C.16: OHS #3) A continuation of the time series in Figure C.15, from left to right: 60, 90 and
120 minutes after injection.
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Chapter C. Time series images:
– 40 kDa TMR/TRITC C.2 OHS

Figure C.17: OHS #4) Image of OHS inoculated CAM 2 minutes after injection of 40 kDa TMR dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.18: OHS #4) Images from the same CAM showing the injected 40 kDa TMR. The images are
chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right is
taken 12 minutes after injection. The CAM was inoculated with OHS cells at day 6, and the images were
taken at day 13. The ROIs were measured in the positions illustrated in Figure C.17. The estimated
extravasation rate was removed from the mean Ki because of failed injection.

Figure C.19: OHS #4) A continuation of the time series in Figure C.18, from left to right: 60, 90 and
120 minutes after injection.
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C.3 Control

Figure C.20: Control #1) Image of cancer free CAM 2 minutes after injection of 40 kDa TRITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.21: Control #1) Images from the same CAM showing the injected 40 kDa TRITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 13.
The ROIs were measured in the positions illustrated in Figure C.20.

Figure C.22: Control #1) A continuation of the time series in Figure C.21, from left to right: 20, 60, 90
and 120 minutes after injection.
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Chapter C. Time series images:
– 40 kDa TMR/TRITC C.3 Control

Figure C.23: Control #2) Image of cancer free CAM 2 minutes after injection of 40 kDa TRITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.24: Control #2) Images from the same CAM showing the injected 40 kDa TRITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 14.
The ROIs were measured in the positions illustrated in Figure C.23.

Figure C.25: Control #2) A continuation of the time series in Figure C.24, from left to right: 15, 60 and
120 minutes after injection.
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Chapter C. Time series images:

– 40 kDa TMR/TRITC

Figure C.26: Control #3) Image of cancer free CAM 2 minutes after injection of 40 kDa TRITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.27: Control #3) Images from the same CAM showing the injected 40 kDa TRITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 13.
The ROIs were measured in the positions illustrated in Figure C.26. The time series appear brighter
than other time series because it contains a black edge at the boarder of the plastic ring in the lower
right corner, which will affect the stack normalization done in ImageJ. However this will not affect the
ratio of the EES and intravascular fluorescence intensity.

Figure C.28: Control #3) A continuation of the time series in Figure C.27, from left to right: 60, 90 and
120 minutes after injection.
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Chapter C. Time series images:
– 40 kDa TMR/TRITC C.3 Control

Figure C.29: Control #4) Image of cancer free CAM 2 minutes after injection of 40 kDa TRITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.30: Control #4) Images from the same CAM showing the injected 40 kDa TRITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 13.
The ROIs were measured in the positions illustrated in Figure C.29.

Figure C.31: Control #4) A continuation of the time series in Figure C.30, from left to right: 60, 90 and
120 minutes after injection.
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C.3 Control
Chapter C. Time series images:

– 40 kDa TMR/TRITC

Figure C.32: Control #5) Image of cancer free CAM 2 minutes after injection of 40 kDa TRITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure C.33: Control #5) Images from the same CAM showing the injected 40 kDa TRITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 13.
The ROIs were measured in the positions illustrated in Figure C.32.
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Chapter C. Time series images:
– 40 kDa TMR/TRITC C.4 Extravasation rates, 40 kDa dextran

C.4 Extravasation rates, 40 kDa dextran

Table C.1: Measured Ki of 40 kDa dextrans, for each of the CAMs inoculated with PC3 cells.

Extravasation rate, Ki (10−4 s−1)

PC3 CAM nr. 2-12 min. 2-120 min.

# 1 1.27

# 2 1.23 0.33

# 3 1.38 0.72

Table C.2: Measured Ki of 40 kDa dextrans, for each of the CAMs inoculated with OHS cells.

Extravasation rate, Ki (10−4 s−1)

OHS CAM nr. 2-12 min. 2-60 min. 2-120 min.

# 1 1.62 0.47

# 2 1.25

# 3 1.12

# 4a 3.12 0.95
a removed from the mean calculated Ki because of failed injection.

Table C.3: Measured Ki of 40 kDa dextrans, for each of the cancer free, control CAMs.

Extravasation rate, Ki (10−4 s−1)

Control CAM nr. 2-12 min. 2-120 min.

# 1 1.13 0.47

# 2 1.08 0.73

# 3 1.33 0.35

# 4 1.13

# 5 1.10
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Appendix D: Time series images: –
3-5 kDa FITC

The appendix include all obtained time series used to calculate the extravasation rate of
3-5 kDa FITC for the three groups PC3, OHS and control. Ki for each CAM is included
in Table D.1, D.2 and D.3.

D.1 PC3

Figure D.1: PC3 CAM #4) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of measured ROIs are shown as yellow circles.

Figure D.2: PC3 CAM #4) Images from the same CAM showing the injected 3-5 kDa FITC dextrans.
The images are chronologically arranged, from left to right, by the time after injection and with a two
minute interval. The first image at the top left is taken 2 minutes after injection, and the last image at
the bottom right is taken 12 minutes after injection. The CAM was inoculated with PC3 cells at day 6,
and the images were taken at 13. The ROIs were measured in the positions illustrated in Figure D.1
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Figure D.3: PC3 CAM #5) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of measured ROIs are shown as yellow circles.

Figure D.4: PC3 CAM #5) Images from the same CAM showing the injected 3-5 kDa FITC dextrans.
The images are chronologically arranged, from left to right, by the time after injection and with a two
minute interval. The first image at the top left is taken 2 minutes after injection, and the last image at
the bottom right is taken 12 minutes after injection. The CAM was inoculated with PC3 cells at day 6,
and the images were taken at 13. The ROIs were measured in the positions illustrated in Figure D.3
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Chapter D. Time series images:
– 3-5 kDa FITC D.1 PC3

Figure D.5: PC3 CAM #6) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of measured ROIs are shown as yellow circles.

Figure D.6: PC3 CAM #6) Images from the same CAM showing the injected 3-5 kDa FITC dextrans.
The images are chronologically arranged, from left to right, by the time after injection and with a two
minute interval. The first image at the top left is taken 2 minutes after injection, and the last image at
the bottom right is taken 12 minutes after injection. The CAM was inoculated with PC3 cells at day 6,
and the images were taken at 13. The ROIs were measured in the positions illustrated in Figure D.5.

Figure D.7: PC3 #6) A continuation of the time series in Figure D.6, from left to right: 60, 90 and 120
minutes after injection.
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D.2 OHS

Figure D.8: OHS CAM #5) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of measured ROIs are shown as yellow circles.

Figure D.9: OHS CAM #5) Images from the same CAM showing the injected 3-5 kDa FITC dextrans.
The images are chronologically arranged, from left to right, by the time after injection and with a two
minute interval. The first image at the top left is taken 2 minutes after injection, and the last image at
the bottom right is taken 12 minutes after injection. The CAM was inoculated with OHS cells at day 6,
and the images were taken at 13. The ROIs were measured in the positions illustrated in Figure D.8

Figure D.10: OHS CAM #5) A continuation of the time series in Figure D.9, 100 minutes after injection.
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Chapter D. Time series images:
– 3-5 kDa FITC D.2 OHS

Figure D.11: OHS CAM #6) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of measured ROIs are shown as yellow circles.

Figure D.12: OHS CAM #6) Images from the same CAM showing the injected 3-5 kDa FITC dextrans.
The images are chronologically arranged, from left to right, by the time after injection and with a two
minute interval. The first image at the top left is taken 2 minutes after injection, and the last image at
the bottom right is taken 12 minutes after injection. The CAM was inoculated with OHS cells at day 6,
and the images were taken at 13. The ROIs were measured in the positions illustrated in Figure D.11
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Chapter D. Time series images:
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Figure D.13: OHS CAM #7) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of measured ROIs are shown as yellow circles.

Figure D.14: OHS CAM #7) Images from the same CAM showing the injected 3-5 kDa FITC dextrans.
The images are chronologically arranged, from left to right, by the time after injection and with a two
minute interval. The first image at the top left is taken 2 minutes after injection, and the last image at
the bottom right is taken 12 minutes after injection. The CAM was inoculated with OHS cells at day 6,
and the images were taken at 13. The ROIs were measured in the positions illustrated in Figure D.13.

Figure D.15: OHS CAM #7) A continuation of the time series in Figure D.14, 60 minutes after injection.
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– 3-5 kDa FITC D.2 OHS

Figure D.16: OHS CAM #8) Image of CAM 2 minutes after injection of 3-5 kDa FITC dextran. The
positions of measured ROIs are shown as yellow circles.

Figure D.17: OHS CAM #8) Images from the same CAM showing the injected 3-5 kDa FITC dextrans.
The images are chronologically arranged, from left to right, by the time after injection and with a two
minute interval. The first image at the top left is taken 2 minutes after injection, and the last image at
the bottom right is taken 12 minutes after injection. The CAM was inoculated with OHS cells at day 6,
and the images were taken at 13. The ROIs were measured in the positions illustrated in Figure D.16.

Figure D.18: OHS CAM #8) A continuation of the time series in Figure D.17, 60 minutes after injection.
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D.3 Control

Figure D.19: Control #6) Image of cancer free CAM 2 minutes after injection of 3-5 kDa FITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure D.20: Control #6) Images from the same CAM showing the injected 3-5 kDa FITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 14.
The ROIs were measured in the positions illustrated in Figure D.19.
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Figure D.21: Control #7) Image of cancer free CAM 2 minutes after injection of 3-5 kDa FITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure D.22: Control #7) Images from the same CAM showing the injected 3-5 kDa FITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 14.
The ROIs were measured in the positions illustrated in Figure D.21.

Figure D.23: Control CAM #7) A continuation of the time series in Figure D.17, 60, 90 and 120 minutes
after injection.
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Figure D.24: Control #8) Image of cancer free CAM 2 minutes after injection of 3-5 kDa FITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure D.25: Control #8) Images from the same CAM showing the injected 3-5 kDa FITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 13.
The ROIs were measured in the positions illustrated in Figure D.24.
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Figure D.26: Control #9) Image of cancer free CAM 2 minutes after injection of 3-5 kDa FITC dextran.
The positions of measured ROIs are shown as yellow circles.

Figure D.27: Control #9) Images from the same CAM showing the injected 3-5 kDa FITC. The images
are chronologically arranged, from left to right, by the time after injection and with a two minute interval.
The first image at the top left is taken 2 minutes after injection, and the last image at the bottom right
is taken 12 minutes after injection. The CAM was cancer free, and the images were taken at day 13.
The ROIs were measured in the positions illustrated in Figure D.26.
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D.4 Extravasation rates, 3-5 kDa dextran

Table D.1: Measured Ki of 3-5 kDa dextrans, for each of the CAMs inoculated with PC3 cells.

Extravasation rate, Ki (10−4 s−1)

PC3 CAM nr. 2-12 min.

# 4 2.73

# 5 2.20

# 6 4.16

Table D.2: Measured Ki of 3-5 kDa dextrans, for each of the CAMs inoculated with OHS cells.

Extravasation rate, Ki (10−4 s−1)

OHS CAM nr. 2-12 min. 2-60 min. 2-100 min.

# 5 3.53 0.87

# 6 5.87

# 7 4.27 1.40

# 8 3.55 1.52

Table D.3: Measured Ki of 3-5 kDa dextrans, for each of the cancer free, control CAMs.

Extravasation rate, Ki (10−4 s−1)

Control CAM nr. 2-12 min.

# 6 5.45

# 7 5.38

# 8 5.63

# 9 5.67
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Appendix E: Materials

Table E.1: List of materials used in cell laboratory. Basic equipment, like centrifuge
tubes, pipettes and incubator etc., is not included in the list.

Name Type Company Catalog
Number

Comments

ETOH 70% Reagent

Cell culture flasks,
TC-25, TC-75 and
TC-300

Equipment VWR 734-2311,
734-2313,
734-2600

If using a different type
of cell culture flasks,
where the cap doesn’t
have a filter, then it
needs to be slightly
opened to allow the pas-
sage of CO2.

DMEM, Dulbecco’s
Modified Eagle’s
Medium

Reagent Life Technologies 41965 With D-Glucose and
L-Glutamine. 500 ml
DMED mixed with FBS
and penicillin to make
medium for PC3.

ECM Gel from
Engelbreth-Holm-
Swarm murine sar-
coma

Reagent Sigma-Aldrich E1270 Long time store at 20◦C.
May be stored at 2-
8◦C for up to 72 hours.
Product will gel within
5 minutes at 20◦C, thus
work should be con-
ducted below 10◦C [69].

Eppendorf Micro-
tubes, 1.5 mL

Equipment Sigma-Aldrich 2317217-
100EA

Used for storage and
transportation of cell
mixtures to use in the
CAM laboratory.

Fetal Bovine Serum,
FBS

Reagent Sigma-Aldrich F7524 50 ml FBS per 500 ml
DMEM

OHS Cell line The Norwegian
Radium Hospital

Derived from a 14 years
old boy with multiple
skeletal manifestations
of osteosarcoma.

PC-3 Cell line ATCC CRL-
1435

Derived from a 62 year
old man.

List continues on next page.
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Name Type Company Catalog
Number

Comments

Penicillin-
Streptomycin

Reagent Sigma-Aldrich P0781 5 ml per 500 ml DMEM
or RPMI 1640 Medium.

Phosphate Buffered
Saline, PBS

Reagent Sigma-Aldrich D-8537 Sterile

Pipette tips, 100-
1250 µl

Equipment VWR 613-1070

RPMI 1640, Roswell
Park Memorial In-
stitute 1640 Medium

Reagent Life Technologies 11875093 With L-Glutamine. 500
ml RPMI 1640 mixed
with 50 ml FBS and 5
ml penicillin to make
medium for OHS.

Trypsin/edta solu-
tion 0.25%/0.02%

Reagent Sigma Aldrich T-4049
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Table E.2: List of materials used in the CAM laboratory

Name Type Company Catalog
Number

Comments

BD Microlance 3
Needle
30G ×11/2”

Equipment Becton Dickin-
son

304000 0.30 × 13 mm.

ETOH 70% Reagent For sterilization.

Fertilized Eggs Animal Nortura SA

Fluorescein
isothiocyanate-
Dextran, average
2,000,000 MW

Reagent Sigma-Aldrich FD2000S Ex/EM: 490/520 nm.
Unit size 100 mg.

Fluorescein
isothiocyanate-
Dextran, average
3,000-5,000 MW

Reagent Sigma-Aldrich FD4 Ex/EM: 490/520 nm.
Unit size 250 mg.

Heat pad Liner,
HP-1

Equipment Wilfa 220-240V ∼ 50Hz 100W.

Heating Plate,
HP-1M

Equipment Physitemp
Instruments, Inc.

Hole puncher, 6 mm
diameter

Equipment Used to make rings for
the inoculation of cells
on the CAMs.

Incubator w/moving
egg-tray

Equipment vidaXL 30065 37-37.5◦C with relative
humidity set above 60%.
The egg tray is tilting
from left to right every
2nd hour.

Injekt-F Solo, sterile Equipment B.Braun 9166017V 1 ml syringe, graduation
intervals of 0.01 ml.

Magnetic stir bar,
triangled 80 mm

Equipment Good tool to crack the
eggs.

Micro Temperature
Controller, MTC-1

Equipment Physitemp
Instruments, Inc.

Microscope Axio
Imager.Z2

Equipment Zeiss 490016-
0001

With epi-fluorescence
imaging

List continues on next page.
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Microscopy Cam-
era AxioCam MRm
Rev.3 FireWire (D)

Equipment Zeiss 426509-
9901-000

1X magnification.

Petri dishes,
polystyrene

Equipment Sigma-Aldrich P5606-
400EA

Size 100 × 20 mm.
Should be wider than
the bottom of the
weighting boat, but
not so wide and tall
that the lid eliminates
aeration.

Phosphate Buffered
Saline, PBS

Reagent Sigma-Aldrich D-8537 Sterile

Pipette tips,
100-1250 µl

Equipment VWR 613-1070 The end of the big end
of the tip is cut of (ap-
prox. 1-1.5 mm) to
make a ring for the cell
inoculation.

Pipette tips,
200 µl

Equipment VWR 613-1072 Suitable size to put
cells onto the CAM.

Standard scissors,
straight

Equipment Used for decapitation.
Fast and humane way
to euthanize the em-
bryos.

Sterican Needle
27G ×11/2”

Equipment B.Braun 9186182 0.40 × 40 mm BL/LB.

Steri-Cycle CO2
Incubator

Equipment Thermo Electron
Corporation

371 37.7◦C. Humidity set
by placing a tub on the
bottom w/sterile water
or PBS. CO2-supply
turned off.

Suture, 6-0 MAXON Equipment Sherwood Davis
& Geck

6532-11 0.7 Metric.
PRE-1 11 mm.

Suture, 7-0 SILK Equipment Sherwood Davis
& Geck

1234-03 0.5 Metric.
CE-20 7 mm.

Spring scissors,
straight, 8cm

Equipment fine, small straight
blades. Used to cut
the surface of the CAM
and to take out tumor
samples.

List continues on next page.

34



Chapter E. Materials

Name Type Company Catalog
Number

Comments

Tetramethyl-
rhodamine Dextran,
Avg 2,000,000 MW

Reagent Invitrogen D7139 Ex/Em: 555/580 nm.
Lysine Fixable. Unit
size 10 mg.

Tetramethyl-
rhodamine-Dextran,
Avg 40,000 MW

Reagent Invitrogen D1842 Ex/Em: 555/580 nm.
Lysine Fixable. Unit
size 25 mg.

Tetramethylrhodamine
isothiocyanate-
Dextrane,
average 40,000 MW

Reagent Sigma-Aldrich 42874 Ex/Em: 550/577 nm.
Unit size 1 g.

Tweezers Equipment Curved shanks.
Small: 1.5 × 5mm tip.
Large: 2 × 10 mm tip.

Vacutainer Safety-
Lok Blood Collec-
tion Set

Equipment BD 367284 23G×3/4"×7" (0.6 × 19
mm × 178 mm). The
plastic tube cut off and
used to fuse glass nee-
dles to syringe.

Weighing Boats
(plastic)

Equipment Globe Scientific GS-3621 Size: 89 × 89 mm × 25
mm. The bottom should
fit/be smaller than the
petri dish and the petri
dish lid should balance
steady on top of the
weighting boat to allow
aeration.
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Appendix F: Thawing, cultivation and freez-
ing of PC3

The following procedure is written by Kristin G. Sæterbø at NTNU [79].
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Appendix G: Cultivation of OHS
The following procedure is written by Kristin G. Sæterbø at NTNU [80].
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Appendix H: Counting cells using a Bürker
chamber

The following procedure is written by Kristin G. Sæterbø at NTNU [81].
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